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Confluence Data Center and Server documentation

Confluence is where you create, organize, and discuss work with your team.

Get started

Kick start your Confluence journey with our navigation and space tutorials.

View guide

Whats new in 7.15

Time to upgrade? Get the low down on the latest and greatest changes in Confluence.

View release notes


https://confluence.atlassian.com/display/CONF715/Confluence+Release+Notes

Get started

Welcome to the Confluence getting started documentation. In this section, you'll find tutorials and other
information that'll be useful for evaluating Confluence, and getting to know it when you're starting out.

Teams in Space

For each tutorial in this section, we'll use a fictional organization known as 'Teams in Space'. Their mission is to:

"Perform flight research and technology integration to revolutionize aviation and pioneer
aerospace technology. Also, land the first humans on Mars by 2020."

You're an astronaut in the 'See Space EZ' team,which is working on the upcoming colonization of Mars.
Go ahead dive into the tutorials, and let us show you around Confluence and some of its handy features.

® Tutorial: Navigate Confluence

® The dashboard

® The space directory

® The space sidebar

® Keyboard shortcuts

® Complete your mission
® Tutorial: Space ace

® Create a project space
Create your personal space
Create the team's PR space
Delete and archive spaces



Tutorial: Navigate Confluence

Confluence is pretty simple to use, once you get to know it. This tutorial aims to get you acquainted with the
Confluence user interface, and show you how and where to perform some common tasks.

Teams in Space

In this tutorial,you'll be working with some new Teams in Space recruits. Let's get to know them.

Alana Baczewski Emma Silvetti William Vladinov
Tech Lead Launch Specialist Aerospace Engineer

Now that you've met your team, let's take a look at your mission.

Mission brief

Your mission commander has thrown you a curveball: this week you'll be training new recruits at Teams in
Space HQ on your collaboration tool Confluence. You just need to know the basics, so we'll go through the
main things you need to know to complete your mission.

Your mission is broken up into the following components:

Get to know the dashboard

Find your way in the space directory
Master the space sidebar

Impress everyone with keyboard shortcuts

Those new recruits will be here tomorrow; we better get started!

Let's go!



The dashboard

The dashboard

The space directory
The space sidebar
Keyboard shortcuts
Complete your
mission

aghrwbdE

The dashboard is the hub of your Confluence site, providing you with access to information and updates that
are important to you. It's also the first thing your new recruits will see, so you need to make a good
impression on this one.

You can get to the dashboard from anywhere in Confluence by choosing thesite logoat the left of the
Confluence header.

The dashboard has a collapsible sidebar that helps you get around:

® Discover
Watch the action unfold in real time withAll updates orcheck out pages with lots of likes and activity
in thePopularfeed.

* My Work
Get lightning fast access to your recently created and edited pages inRecently worked on, get back
to that page you stumbled across yesterday inRecently viewed, and have mission critical pages on
speed dial underSaved for later.

® My Spaces
This is where you can keep links to the spaces that you hop in and out of several times a day.

If you're a Confluence admin you can give the dashboard some personality by adding useful
announcements, links, or a photo from your last mission (or office party). The whole right hand column is
ready and waiting for you to customize.

= X Confluence Spaces v People  Create -

o — O’ A.'I' . pcpular Invite Users  Create Space
7 Il upclates

= Popular £ Re: Whan shoubd we launch? 4
Emma McRas Welcome to Confluence

B When should we launch? 22 B3
Ryan Low P

D B Team playbook update: customer interviews 2 7 {
.
X Alana Grant

WY SPACES Al Mission essentials

v team B Solar powered charging stations
Emad Abdi

kK Team Space
[
Around the base

B Re: Team playbook update: customer interviews 1
Cassle Dwens Bixe

Sata

B Bike storage

argi
" 3¢

v ‘ Birthdays this week

‘; Jessie Emmerson

W-mockup.jpg 2 [: {]
Emma Mciae

Upcoming events

18 Apr 2018 Launch party!

1. Discover: see what's happening in your site.
2. Your work: get work done with recent and useful pages at your fingertips.
3. Customize: admins can add useful content to welcome people to the site.

Try clicking one of the spaces on the sidebar, then return to the dashboard by clicking thesite logo. Even
when your shuttle is spinning out of control, the dashboard is there to orient you.

You'll discover more about the dashboard as you get to know Confluence, but, for now, let's move on to the
space directory.
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(® Pro tips
® You can choose to set any page as your personal home page
® You can always get to the dashboard at htt ps://yoursite.con wi ki/dashboard.

action
® Your Confluence admin cancustomize the global dashboardthat all users see

Next
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The space directory won't let you look up ET in the intergalactic phone book, but itwilllet you see and filter all
the spaces in your Confluence site. Spaces are places to collect pages with a common theme you can
create as many spaces as you like and you can find them all in the space directory.

Here are some tasks to get you comfortable using the space directory:

1. Visit the space directoryTo get to the space directory, chooseSpaces>Space directoryin the
Confluence header.

2. Choose the spaces you'll use the most No doubt there'll be a space or two that you'll use on a
regular basis. Click the star to the right of a space to make it appear under My Spaces on the
dashboard.

3. Choose space categories Once you're there, you'll see a list of all the spaces in your Confluence
site. Choose the 'My Spaces' category on the left to see only the spaces you marked with a star. Then
choose all spaces again.

4. Filter the list of spaces Type part of a space name in theFilterfield at the top right. That'll quickly
narrow down the list of spaces if there are a lot of them.

= Z Confluence spaces ~ People Create - Feedback
Space Directory D Ereate Foace
All Spaces Site Spaces
Site Spaces Space Description Categories
Personal Spaces Dy e ® *
My Spaces
&i IT Knowledge Base knowiedge-bases
Archived Spaces
B social
CATEGORIES
Knowledge-bases kil Teamsin Space @ *
Hint: Your space administrator can organise spaces into categories, Learn maore,

@. You can also categorize spaces with labels you create yourself. We're not going to cover that here,
but, if you'd like to know more, you can check outUse Labels to Categorize Spaces.

Understanding and using the space directory will make it much easier to find pages and blog posts that are
relevant to you.

You're ready to impress those new recruits with your knowledge of Confluence's space directory; now it's
time to sneak a peek at the space sidebar.

Next
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What's in the sidebar?

The sidebarisa feature of every Confluence space; it's where you'll find the page tree (a hierarchical list of
pages in the space), customizable space shortcuts, and a link to the space's blog.

The See Space EZ team will find their meeting notes, decisions, requirements, and other pages in the
sidebar. Basically any page you create in the space will appear in the sidebar by default.

(-:-*) When you use certain page templates, like meeting notes, Confluence will automatically add an
index page to your space shortcuts. The index page is just a place where you can view all pages of
the same type meeting notes in this example in one place.

The space's blog is great for announcements and what's new-type updates.
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4
H Teams in Space *

F Pages
99 Blog

SPACE SHORTCUTS
F Decision log

& Our Kanban board

F Media assets

PAGE TREE
v Meeting notes
2017-12-12 SeeSpaceEZ Tez
» 2018-01-18 Meeting notes

»  Decision log

> Product Planning i
> Product Requirements
> Teams in Space PR

Meet the SeeSpaceEZ Team

> Teams in Space PR

{3 Space tools v «

1. Space shortcuts: link to Confluence pages or other pages on the web
2. Page tree: hierarchical view of pages in this space.

The page tree in the sidebar shows the 200 pages closest to where you are. Hit Show all pages, if you want
to see all the pages in a space.

Configure the sidebar

You can expand or collapse the sidebar using the left square bracket ([) on your keyboard, or by dragging it
with your mouse.

There are lots of things you can change in the sidebar, but we'll stick to the basics just enough to train your
new recruits.

G} You need to be a space admin to complete this task. Take a look, but feel free to skip it if you're not
an admin of any space.

Try this out:
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1. ChooseSpace tools>Configure sidebarfrom the bottom of the sidebar (or the cog menu if your
sidebar is collapsed)

2. Add a space shortcut by clicking+Add link
Shortcuts can be toConfluence pages or spaces, or to any other content on the web. Try linking tothis
blog post, which mentions Teams in Space (we're always after a plug at Teams in Space HQ!)

You can also hide things like the space's blog in the sidebar, if they're of no use in the space.

The sidebar is pretty easy, right? You'll be schooling those recruits in no time. Next up: Impress them with
your knowledge of keyboard shortcuts.

Next
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Give a person some space food, and they'll eat for a day; teach a person to rehydrate their own space food,
and they're set for the whole mission. Or something like that. Keyboard shortcuts fall into this basket. We
could give you a list here, but then you'd need to keep referring to this page. The best way to go is to show
you how to find the list of keyboard shortcutswithinConfluence.

Your recruits also need to work fast, so you'll need to pass this wisdom on to them.

Find the keyboard shortcuts

To open the list of keyboard shortcuts in Confluence, do any of the following:

® Choose thehelp iconat top right of the screen, then chooseKeyboard Shortcuts
®* When viewing a page, pressShift+?
* While editing a page, choose the question mark icon ? in the editor toolbar

What you'll see is a dialog listing the available keyboard shortcuts, for your operating system, in Confluence.

Keyboard Shortcuts

General

Editor Block Formatting Rich Formatting

Editor Autoformatting Paragraph R |« |6 Fites and images H + M
Heading 1 ® (=1 Link ® o+ K
Heading & % + 6 nsert markup ¥ + sShit + D
Preformatted 8o x | T Macr # = Shift + A
Quote ® 0+ 8 ® o+ Shit o+ |
Bullet st # + Shift + B #® + Shift + X
Numbered list ¥ 4+ Shit + N Capy table raw ¥ + Shh + | C

Saste table row ® + Shit + WV

Editing Actions
Preview ¥ + Shit + E
Save B |« |'B

The keyboard shortcuts are broken up into 3 categories:
® General Global, page and blog post shortcuts.

® Editor Text editing and formatting shortcuts.
® Editor Autoformatting Wiki markup and autoformatting shortcuts.

@ You can turn the 'General' keyboard shortcuts off when you visit theGeneraltab in the keyboard
shortcuts dialog.

Take some time to open the dialog and take a look at the shortcuts, and maybe find some you'll use a lot.
Then, start practising!

Want a printable sheet of keyboard shortcuts?Keyboard shortcuts infographic - you're welcome.

Next, we'll wrap up this mission and give you some ideas about where to head from here.


https://atlassianblog.wpengine.com/wp-content/uploads/2018/01/keyboard-shortcuts-infographics.pdf
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Well done, astronaut, you've acquitted yourself admirably. I'm sure those new recruits will be mightily
impressed with your knowledge of Confluence.

In this tutorial, we've:

® Explored the anatomy of the dashboard

® Navigated using the space directory and favorited a space

® Taken a look at and customized the space sidebar

® Found a handy list of keyboard shortcuts to help you work faster

Just look at your team's adoring faces...

If you'd like to take things to the next level, check out our tutorial on becoming aspace ace.



Tutorial: Space ace

This tutorial will take you on a journey through Confluence to create and customize spaces, and delete them
if you want to, so you can achieve the rank of 'Space Ace'l

You'll need to have the 'Create space' and 'Create personal space' permission to complete this tutorial. If
you've just set up Confluence, you won't have any trouble; if you're using an existing instance and you're not
an admin, speak to your Confluence admin to make sure you have the right permissions.

Teams in Space

In this tutorial you're a new recruit on the Teams in Space crew, but, even though you're new, you'll be given
a lot ofresponsibility. You need the power to go with it.

Mission brief

You're in charge of organizing information and resources for the planned mission to Mars.There's going to
be plenty of important information, and it must be readily available to the people who need it. Some
information, though, will be sensitive, and may be ‘for your eyes only."You'll use the power and flexibility of
Confluence spaces to organize information, and make sure it's visible to the right people.

Your mission is broken up into the following components:

® Create a space to house all of the important information related to the mission
® Createyour own space to keep yourself organized
® Create a public relations space, where you'll introduce your team the world

What's a space?

Well, being an astronaut, | hope you know whatspaceis, but what's a Confluence space all about? It's really
just a place to put related things, like information pages and files. But spaces also give you a place to
collaborate with groups of people, whether that's your team, people working on a common project, or the
whole world.

Every space has its own permissions, allowing you to grant access and other privileges to the right people.
They also have a blog, so you can post important messages and updates to whoever can see the space.
You can have as many Confluencespaces as you like, and you can archive or delete spaces when you no
longer need them.

Enough about that; let's begin.

Start the mission!



Create a project space
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4, Delete and archive

spaces

The Mars colonization crew needs a place to put all their mission-critical information and resources, and
you're charged with setting it up. This part is going to be easy, because the information needs to be viewable
by the entire Teams in Space organization. That means we can set up the project space without any special
permissions.

If you haven't done so already, open up Confluence and log in so we can get started.

Create the space

1. ChooseSpaces>Create spacefrom the Confluence header

2. Select theBlank spaceoption and chooseNext

3. Enter aSpace name for this space, we'll call it 'Mars Colony', as it's being used for the Mars
colonization project.

4. Change theSpace keyto 'MARS' this step isn't absolutely necessary, but it helps people if they're
navigating to this space by name. The space key forms part of the URL, so making it a word or name
makes it much easier to associate with your project.

5. ClickCreate

You now have a space set up for the Mars colonization project. Because everyone at Teams in Space HQ
needs access to the information in this space, you don't need to do anything with the space's default
permissions. It's visible to everyone in your organization, but not to the general public.

Every space has a default home page, which you can customize to suit your needs. Add the following image
and text to your space's home page to get things started. Just clickEdit(or pressEon your keyboard) to edit
the home page, and copy and paste the text. For the image it's best to drag it to your desktop and save it
there, then drag it into your page. That'll make sure the image is attached directly to the page.

HitSavewhen you're happy with the home page.

Ahuman mission to Marshas
been the subject ofscience
fiction,engineering, and
scientific proposals throughout
the 20th century and into the
21st century. The plans
comprise proposals to land onM
ars, eventuallysettling onandter
raforming the planet, while
exploiting its moons,Phobosand
Deimos.

Exploration of Marshas been a
goal of national space
programs for decades.
Preliminary work for missions
that would involve human explorers has been undertaken since the 1950s, with planned missions typically
being cited as taking place 10 to 30 years in the future when they are drafted. Thelist of manned Mars
mission plans in the 20th centuryshows the various mission proposals that have been put forth by multiple
organizations andspace agenciesin this field ofspace exploration.
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Your 'Mars colony' space is ready for your team to add pages to. If you want to find it again, chooseSpacesin
the Confluence header, and select it from the list; to add a page to it, navigate to the space and hitCreatein
the header.

Now it's on to your personal space; a place where you can work in peace, and be sure that no one's looking
over your shoulder.

Next
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Create your personal space
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As a newbie on the team, you might want to keep some work to yourself until you're ready to present it.
There's always the chance your mission commander will also send you some information that's ‘for your
eyes only,' and you'll need to keep that in a safe place.

For this part of the mission, we'll be creating a special type of space: a personal space. We'll be using your
personal space like a sandbox, at least to start with somewhere you can play around, draft pages, try out
features, and generally see what spaces are capable of.

Create your personal space

1. Choose your profile picture at the right side ofthe Confluence header
2. SelectAdd Personal Space...
3. HitCreate

You've now got a space that you can call your own. But we still need to lock it down to make sure it's
only visible to you.

= X Confluence sSpaces v Pecpie  Create = Feedback
Pages @ # Edit 17 Save for later © Watching =% Share
Cassie Owens *
2 I
Cassie Owens's Home

& Profile Creatod by Cassio Cwions Just a mament age
B Pages About Me (Cassie Owens)
37 Bleg You may edit this page to Include additional information about yoursell,
SPACE SHORTCUTS E-mail: cassie@mycompany.com
Hera you can add shortcut links to the Na\.rigate space
muost important content for your team or Recen!ly Upd ated
project. Configure sidebar.

As you and your team create
PAGE TREE content this I e Search

display the lates
Get started by adding some pages to this
space, Create page

) Space tools ¥

4. ChooseSpace tools>Permissionsfrom the bottom of the siderbar
5. HitEdit Permissions(enter your password if prompted)

You should see theconf | uence- user sgroup listed underGroups. To the left of the list of
permissions is theViewpermission, which determines whether everyone in that group can see your
space.

6. UncheckViewand hitSave allat the bottom of the page

You're now the only one that can view this space. Feel free to try anything in this space, and store super
secret stuff here.

Next
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Now it's time to go public; the world needs to know about the mission and its brave participants.

In this step, we'll create a team space and open it up to everyone. That's right you can open Confluence
spaces up to anonymous (not logged in) users.

@ In order to allow anonymous access to your Confluence site, a site admin needs to grant
anonymous users the 'Use Confluence' permission. Don't worry if you can't do that, or if it's not
done; it's just something to note if you're opening up your Confluence site for real.

Create a Team space

ChooseSpaces>Create spacefrom the header

SelectTeam Spaceand hitNext

Enter aSpace name(let's call it 'Mars PR’)

Change theSpace keyto 'MarsPR'

If there are other people using Confluence with you, feel free to add them asTeam members(you can
remove them later), or just stick with yourself for now

Paste this in as theDescription:Follow the progress of the brave Teams in Space astronauts as they
embark on their mission to colonize Mars.

arwbdE

o

Great! You now have a team space, again with its own home page. This home page is a little different to the
project space and your personal space you'll see any team members you added, listed on the home page.

Create team space

Space name Mars PR About team spaces

Share knowledge and collaborate on
projects, processes and procedures with
your team. They will be notified abaut this
space and all updates. Team members will
be granted permissions and added as
waltchers of the space.

Space key’ MPR @

Team members (@ Cassie Owens = @) Ryan Lee =
& Emad Abdi x @ Emma McRae x

Description  Follow the progress of the teams in space
astronauts as they embark on their mission
to colonise Mars

Back [ -EIEW Close

Each space you create also has its own blog, so your social media team will be able to create posts in this
space and speak directly to all those adoring fans. But none of those fans can see this space. Yet.

Allow anonymous access
It's time to let the world in by changing the permissions on this space.
1. ChooseSpace tools>Permissionsfrom the bottom of the sidebar

2. Scroll down until you seeAnonymous, then hitEdit Permissions
3. Tick theViewpermission for anonymous users and hitSave all
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That's it. You can now share the space's URL, which will be http(s)://<your_confluence_site>/display
/MarsPR. Visitors to that space don't need to log in, or have a license for Confluence.

Next
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Delete and archive spaces
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We hope you've had a successful mission, and learned a bit about the power and versatility of Confluence
spaces. Flash forward 18 months, and just look how well the colony is coming along!

If you need to clean up old spaces (or destroy the evidence of a failed mission!), you can either archive or
delete a space. Archiving just means it won't show up in the regular search, whereas deleting is obviously a lot
more permanent.
To archive a space:

1. ChooseSpace tools>Overviewfrom the bottom of the sidebar

2. ClickEdit Space Details

3. Change theStatusfrom 'Current’ to 'Archived' and hitSave
To delete a space:

1. ChooseSpace tools>Overviewfrom the bottom of the sidebar
2. Select theDelete Spacetab

What next?

If you'd like to know more about spaces and the permissions that govern them, check outSpaces andPermission
s and restrictions in the Confluence documentation.

Teams in Space HQ, signing off.



Spaces

What is a space?

On this page:
Spaces are Confluence's way of organizing content
into meaningful categories. Think of it like having ® Whatis a space?
different folders into which you can put your work. ®* How do | use a space?

Related pages:
Spaces come in two main varieties:

¢ Create a Space
* Site spaces These spaces are found in the ® Space Permissions Overview
Space Directory and are the areas where * Navigate Spaces
you create content and collaborate with ¢ Organize your Space
others. They are sometimes called global : ’CAZ\usg_omlzeSyour Space
spaces. rcnive a space
* Personal spaces Every Confluence user * Export Content to Word, PDF, HTML and
can set up a personal space which they can . XML
keep private or make public so others can Delete a Space

view and edit. Personal spaces are listed in
the People Directory and found under your
personal profile.

How do | use a space?

Create as many spaces as you need to get things done:

® Team spaces Give each team (QA, HR, Engineering, Support, ...) their own space so they can focus
and make their information easier for everyone to find.

® Project spaces Put all the information related to your project in one place. This allows everyone to
work together in Confluence instead of emailing back and forth.

® Personal space Store everything you're working on individually, keep your to-do lists, and polish any
content before you move it into another shared space.
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Stay up to date with spaces

® \Watch a space to stay up-to-date with any changes.
® Add important spaces to your dashboard so that they're easy to find again.

Administer spaces
If you have admin permissions for a space you can:

® Change the colors, logo, sidebar and homepage of that space.
® Control who can view and edit your space.
® Make your space public to share it with people who don't have access to Confluence.

Space Permissions
Some things we should make clear about space admin permissions:

® The person who creates a space automatically has admin permissions for that space.

® Space admins can grant admin permissions to others.

® Space admins don't have to be Confluence admins and can have special permissions for a single
space. For example, you are the admin for your personal space, no matter what kind of access you
have anywhere else.

Want more ideas for using spaces? Check out our kickass guides on how to:

Use Confluence as a Knowledge Base

Develop Technical Documentation in Confluence
Use Confluence as your Intranet

Use Confluence for Software Teams
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Create a Space

There's no limit to the number of Spaces you can create on Confluence.
You can choose to set up a space for each team, project, or a mix of both On this page:
depending on your needs.

Each space in Confluence functions autonomously, which means that each ¢ Create a personal
space: space
® Create a site space
® Has its own homepage, blog, pages, comments, files, and RSS ® Space permissions
feeds. ® Linking related

® Can be customized with different color schemes, logo and sidebar. Spaces

® Has its own set of permissions, as set by the space admin. ® Tips
For example, an IT team can create one overarching space with all their roa Related pages:

dmaps, details of sub-teams, and a list of all the people and roles within that
team. They could then create a new space for each sub-team, such as
Quality Assurance, Developers, and Documentation, with guidelines, long
term plans, and knowledge articles within them. Each project that these
teams work on could also have its own space, which could be linked to the
team spaces using labels.

® Spaces

® Space Keys

® Create a Space
From a Template

Create a personal space

Your personal space is always owned by you, and you can use it to store
your individual work, keep track of tasks, blog about what you've been
working on, or just use it to polish your pages before you move them into a
site space.

1. Choose your profile picture at top right of the screen, then choose Add Personal Space..
2. Choose Create.

You can change the permissions for your space at any time to determine who can and can't access the
content. So if you want it to be a private sanctuary, that's no problem.

@To create a personal space you need the 'Personal Space' global permission.

Create a personal space

With a personal space, you can...

1 Stay organised 2 Share news 3 Introduce yourself
Keep your notes, task lists, files Use your blog to make Customise your personal
and other personal content announcements, capture ideas hemepage and introduce
organised. and share learnings. yourself to the team.

Back Create [E=LES

Create a site space

You can create a site space for any team or project that would benefit from having a place where people can
work together and store related files. You can create these as blank spaces, or use templates, called space
blueprints , to help you create Team spaces, Knowledge Bases spaces, or Documentation spaces quickly
and easily.

1. Hit Spaces > Create space in the header.
2. Pick a type of space.
3. Enter the required details and create your space.
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1.Choose your space key carefully as you can't change this later.

Each space you create will automatically have a home page that you can customize to display relevant
information for people viewing the space. If you use a space blueprint when creating a space, it will
customize your home page for you.

@To create a site space you need the ‘Create Space' global permission.

Create team space
Space name”  Marketing Team About team spaces
Space key'  MARKETING & Share knowledge and collaborate on
T B projects, processes and procedures with
Ttk b (D Cassic Owens x @ Emad Abdi x your team. They will be notified about this

space and all updates. Team members will

& Emma McRae »

- be granted permissions and added as
4 Harvey Jennings *

watchers of the space.

Description  This is the space for all things marketing

Back m Close

Space permissions

Each space is created with a set of default permissions. The user who created a site space is automatically
granted 'space admin' permissions for that space, which means that they can then grant permissions to
other users and groups. See Space Permissions Overview for more information.

@System Administrators can edit the permissions of spaces in their Confluence site at any time.

Linking related spaces

You can link related spaces together using labels. This will create categories in the space directory for each
label, grouping all spaces with that label together.

Space Directory ® Create Space
Al Spaces Knowledge-bases
Site Spaces Space Deseription Categories
N s fEanal Branas " <
Personal Spaces ﬁ’ IT Knowledge Base knowledge- @
" bases
My Spaces
Archived Spaces z Marketing Knowledge base This is the space for all things ggg:‘;ﬁdge- @
marketing
CATEGORIES : o : ! .
Hint: Your space administrator can organise spaces into categories, Learn mare.
Knowledge-bases

® You can also add a space description to make it easier for visitors to find the right space within each
category.

® To help navigate between related spaces, you can use the Spaces List Macro on a page and filter by
category. This will let you insert a list of all the other spaces in a certain category into your space. You
can use this, for example, to keep a list in your team space of all the project spaces your team is
working on.

® If you want to link to only certain pages of related content, rather than whole spaces, you can use the
Content Report Table Macro. You can use this, for example, in a space that functions as a workplace
directory, to create a list of all the team pages with everyone's roles and contact details across your
organization.

Created in 2021 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/
https://confluence.atlassian.com/display/CONF715/Use+Labels+to+Categorize+Spaces#UseLabelstoCategorizeSpaces-spacedes

Confluence 7.15 Documentation

Tips

® |f your needs change, or your spaces grow too big, it's easy to copy or move content from one space
to another.

® |If the content or purpose of your space changes, you can update the space name, logo, colors and de
scription to reflect those changes.

® |f you no longer need a space, such as when a project has been completed, you can archive it, which
makes it less visible but retains the content on your site so that you can still refer back to it later.
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Create a Space From a Template

Confluence comes with a number of templates, known as space blueprints,
which have a customized homepage and sidebar, and may contain page
blueprints or sample content to help you get started. * Create a Space

Related pages:

@. This page is about space blueprints. You can also use Blueprints to
create individual pages.

@Your Confluence administrator can customize or disable particular
blueprint templates, so they may be different to the examples shown here.

Types of space blueprints
Team space

A great building block if you are using Confluence as an intranet or to manage teams. Team spaces highlight
the members of the team, and grants permissions to those users accordingly.

Knowledge base space

This space blueprint uses search and page labels to make content easier to find, right from the space
homepage. It also contains two page blueprints for creating how-to and troubleshooting articles. The
templates used in these page blueprints are completely customizable. The Knowledge Base space blueprint
also Use Jira applications and Confluence together.

Documentation space

This space blueprint displays the full page tree in the sidebar and hides other sidebar features including
blogs and shared links. The homepage uses search and page labels to make content easy to find. Add the
‘featured' label to any page you want to highlight on the homepage. This space does not include any page
blueprints but you can create and promote templates for your documentation authors to use.

Software project space

This space is designed to help you organize your software project. The purpose-built space home page lets
you view and edit your roadmap, see team members, and Use Jira applications and Confluence
together#JIRA Software. Create pages in this space for requirements, meeting notes, decisions, retros, and
more.

@The software project space blueprint will only appear if you have linked Confluence to your Jira Software
instance.

Filter Help
Create space :
Blank space e ; Y Personal space
Start with a blank space. ‘4 Keep your notes, task lists and other content
organised.
P Documentation space ) Knowledge base
'.Ii‘r Create and manage technical documentation L’ Capture and share best practices and
for your praducts solutions to commaon problems.

7o Team space
L';." Collaborate and share resources with your
team.

- L
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Check out our guides for some more tips on how to:

Use Confluence as a Knowledge Base

Develop Technical Documentation in Confluence
Use Confluence as your Intranet

Confluence for Software Teams
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Space Keys

Each Confluence space has aspace key,whichis a short,unique identifier

that formspart of the URL for that space. Related pages:
® Create a Space
Create team space
® Create a Space
Space name”  Marketing Team About team spaces From a Template

* | MARKETING ® Share knowledge and collaborate on
projects, processes and proceduras with
your team. They will be notifled about this
space and all updates. Team members will

Team members (P Cassie Owens x @ Emad Abdi x
& Emma McRae »

: : be granted permissions and added as
4 Harvey Jennings =

watchers of the space.

Description  This is the space for all things marketing

Back m Close

When you create a site space, Confluencewill suggesta space keyor you can enter your own key to make it
more memorable.

For example, you might give your marketing team's space a key of MARKETING. You can then navigate
directly to the space using a URL like this -htt p: / / <your si t e>/ di spl ay/ mar ket i ng

@Personal spaces always use your username as the space key.

Choosing a space key
Each space key:
® Must be unique.
® Can contain any alphanumeric character (a-z, 0-9).

® Can be up to 255 characters long.

i. You can't change the space key after you create your space, so choose your space key carefully!



Navigate Spaces
How is content arranged in spaces?

Think of a space as the container that holds all the important stuff a team,
group, or project needs to work. These are autonomous that means that
each space has its own pages, blogs, files, comments and RSS feeds.

Each space is automatically created with a homepage - the first page you'll
see when you navigate to the space. You can edit your homepage and your
sidebar to help people navigate their way around your space.

Spaces can't be nested you can't have a space within a space but you can
Use Labels to Categorize Spaces. Spaces with the same label will appear
together in the the space directory and in the recent activity area of the
dashboard.

On this page:

® How is content
arranged in
spaces?

® View all spaces in
Confluence

Related pages:

® QOrganize your
Space

® Watch Pages,
Spaces and Blogs

® Pages and blogs

® Search

Inside the space, you can nest your pages, and you can create as many levels of hierarchy as you need.
Each space also has its own blog, which lets you share news and make announcements. Blog posts are a

great way to keep people involved in what's going on in your team or project.

You can set different levels of access for each space, and the pages and blogs within it, usingSpace

Permissions Overview.

project

]
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View all spaces in Confluence

There are two main ways to view spaces in Confluence:

JEaEE

® The space directorychooseSpaces > Space directoryin the Confluence headerfor a list of all the
site and personal spaces you have permission to see. Filter the list of spaces by selecting from the

categories on the left of the space directory.

® The dashboard you can make your most useful spaces appear underMy spaceson the dashboard.
Choose the star icon in the space sidebar or space directory to add a space toMy spaces.
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Spaces v  People Create ---

RECENT SPACES

' Dev team

& Marketing Knowledge base
& Teams in Space

@@ Social

® |T Knowledge Base

Space directory

Create space

Thespaces menuin the header also displays a list of your recently viewed spaces, allowing you to quickly
navigate to the things you view most often.

The Spaces List Macro allows you to display a list of spaces on a Confluence page, and lets you filter them
by category.
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Space Permissions Overview

Every Confluence space has its own set of permissions which determine
what people can do in the space.

Related pages:

® Confluence Groups

Space permissions are set by the space administrator. The user who * Assign Space
created the space is automatically a space administrator, and other users Permissions
can also be granted Space Admin permission. * Page Restrictions

® Global Permissions
Overview

(¥) This page is about Space Permissions. Confluence also lets you set Page Restrictions.

Edit space permissions

To change permissions for a space, chooseSpace tools>Permissionsfrom the bottom of the sidebar, then
chooseEdit Permissionsto change permission settings.

SeeAssign Space Permissions for more details.

Permissions Summary
The following permissions can be assigned in a space:

Category

All

Pages

Blog

Attachmen
ts

Comments

Permission

Viewgives you permission to access the content in this space, and see it in the space
directory and other places like the dashboard.

Delete owngives you permission to delete any pages, blogs, attachments and comments
you've created in this space (regardless of whether other users have subsequently edited
the content).

Add page gives you permission to create new pages and edit existing pages in this space
(assuming the page is not restricted for editing).

Delete page gives you permission to delete any page in the space.

Add blog gives you permission to create new blog posts and edit existing blog posts in this
space (assuming the blog post is not restricted for editing).

Delete page gives you permission to delete any blog post in the space. Delete permission is
also required to move a page or blog to a different space.

Add attachment gives you permission to upload (attach) files to pages and blog posts in this
space, and to edit attached files using the Companion app.

Delete attachment gives you permission to remove attached files from pages or blog posts
in the space.

People with only Add page or blog permissions can still insert existing attached files in the
editor, and remove files from the editor, so they're not displayed on the page or blog post.
They can't however upload a new file, a new version of an existing file, edit an existing file
using the Companion app, or delete the attached file itself.

Add comments gives you permission to add comments to a page, blog post or attached file.

Delete comments gives you permission to delete any comment on a page, blog post or
attached file.
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Restrictions Add restrictions gives you permission to apply page-level restrictions to a page or blog
post. You can restrict a page for viewing, or just for editing.

Delete restrictions gives you permission to remove restrictions from any page or blog post.

Mail Delete mail gives you permission to delete mail items that have been archived in this space.
This is not a commonly used feature.

Space Export space gives you permission to export all the contents of the space to PDF, HTML or
XML. This is different to single page exports - anyone who can view a page can also export it.

Admin gives you permission to access all space administration tools, including things like
permissions, templates, look and feel, and the ability to delete the whole space.

Here's how it looks on the Permissions screen:

All Pages Blog Attachments Comments Restrictions  Mail Space

Wiew Delste Add Delete  Add Delete  Add  Delete  Add  Delste  Add/Delete Delete  Export  Admin
O

atlassian-staff ] e © ¢ o © o B o o -] (] @ <]
confiuence-users [ -] [ =] [~ ] [ =] (-] [ x | [ -] x| [ -] a [ x | [ =] [} [ ]

How space permissions work
Space permissions are additive. If a user is granted permissions as an individual or as a member of one or

more groups, Confluence will combine these permissions together. This is sometimes known as their
effective permissions.

Sasha is a member of the conf | uence- user s group and the devel oper s group. The conf | uence-
user s group has 'export’ permission, but does not have ‘restrict' permission. The devel oper s group
has 'restrict’ permission but does not have ‘export' permission.

By being a member of these two groups, Sasha can restrict and export content. The permissions do not
conflict, they combine to determine what Sasha is allowed to do in this space.

If you have Confluence Data Center,Inspect permissions provides space admins and Confluence
administrators a great way to view someone's effective permissions.

Who is the space admin?

The user who created the space is automatically a space administrator, and other users can also be granted
Space Admin permission.

To find out who is an administrators in your space, either:
® Go toSpace Tools>Overview in the space.
® Go to Spaces > Space Directory on the header, then choose theSpace Detailsicon beside the

space.

If you accidentally deny all admin access to a space, so that nobody has access to administer the space any
more, you can ask someone with Confluence Administrator global permission to recoverSpace Permissions.

Space admin superpowers
Space administrators can do a lot of things in the space such as:

® grant permissions to users and groups (and themselves)
® create templates
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change the look and feel

delete the space

manually remove page restrictions (including on pages they can't see)
manage watchers, to change who is watching a page

inspect permissions to see what users can do in the space (Data Center only)

Confluence administrators aren't necessarily space administrators.If they don't have the Space Admin
permission (as an individual or member of a group), they can recover permissions to the space, which will
grant them space admin permission.
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Assign Space Permissions
If you are the administrator of a space, you control the permissions for it.

You can choose to assign/revoke permissions on either an individual user
basis, or usingConfluence Groups.

@ Want to know the best way to set permissions for your team's
needs? Check out our Permissions best practices guide.

To view the permissions for a space:

1. Go to the space and chooseSpace tools>Permissionsfrom the
bottom of the sidebar

2. Choose Edit Permissions.

The Edit Space Permissions page is divided into the following sections:

On this page:

Grant space
permission

Set default space
permission for all
new spaces
Revoke space
permissions

Inspect permissions

® Manage and

recover space
admin permissions

Related pages:

Space Permissions
Overview

Global Permissions
Overview

Make a Space
Public

Give Access to
Unlicensed Users
from Jira Service
Management

® Licensed Users -this is where you grant permissions to groups and individual users.
® Anonymous Access- this is where you grant permissions to users who are not logged in (essentially
making the space public). Note: allowing anonymous access in a space will allow all logged in users

to see that space, even if your site is notPublic.
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Permissions  Restricted Pages

Licensed Users

Groups
Grant permissions for this space to all the members of a group
All Pages Elog Attachments Comments Restrictions  Mail Space
View Delete Add Delete Add Delete Add Delete Add Delete Add/Delete Delete Export Admin
Own
confluence- @ @ © @ 9 B o 8 o B a a e a
users
developers @ @ 6 6 o 60 o o o o o a -] [ ]

Edit Permissions

Individual Users

Grant permissions to individual users, regardless of which groups they are a mamber of.

All Pages Blog Attachments Comments Restrictions  Mail Space
View Delete Add Delete Add Delete Add Delete  Add Delete  Add/Delete Delete  Export  Admin
Owin
Rach o e © © © © © © o o o @ @ ]
Admin
{admin)

Edit Permissions

Anonymous Access

Grant perm

ns Lo anonymous

mmend limiting this to viewing and commenting. People who are
logged in will also get these permi rator has turned off anonymaous access for this site.
All Pages Blog Attachments Comments Restrictions  Mail Space
View Delete Add Delete Add Delete Add Delete Add Delete Add/Delete Delete Export Admin
Cwn
Anonymous [ 8 B 8 8 B B o B @Bo a %] %] %]

Edit Permissions

Grant space permission
To add a new user or group to the permissions list:

1. Search for either a group or userin their respective sections and chooseAdd.The group or user will
appear in the list.

2. Select the specific permissions you'd like to apply then chooseSave all.

You can bulk assign or revoke permissions by selectingSelect AllorDeselect All.

Default Space Permissions # Edit Permissions

These are the default permissions that will be assigned to groups when someone adds a new space. The "confluence-administrators' group
always has all permissions for all spaces, and any permissions set for it here will be ignored.

All Pages Blog Attachments Comments Restrictions  Mail Space
View Delete Add Delete Add Delete Add Delete Add Delete | Add/Delete Delete  Export  Admin
Qwn
confluence-
© © ©o @ © @B © B © @O o @B o o

Permissions are managed on a space by space basis. Your Confluence Administrator is able to set default
space permissions, which will apply to any new spaces.

Set default space permission for all new spaces

If you regularly need to grant permissions to the same groups each time a new space is created, you should
consider updating the default space permissions.

Created in 2021 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Confluence 7.15 Documentation

To set the default space permissions:

1. Go tom> General Configuration>Space Permissions.
2. ChooseEdit Permissions.

Default permissions are configurable forgroupsonly, not for individual or anonymous users.

Revoke space permissions

To remove a user or group from the space permissions list, deselect all the checkboxes for that user or
group and save the changes. The user or group won't appear in the list once you save.

Inspect permissions

If you need to troubleshoot why someone can or can't do something in your space, and you have a Data
Center license, you can inspect permissions. Seelnspect permissions for more information.

Manage and recover space admin permissions

If you're aConfluence Administrator you can recover permissions to a space. This is useful when the only
person with Space Admin permissions to a space leaves your organisation, for example.

To recover Space Admin permissions:

1. Goto E> General Configuration>Space Permissions.
2. Locate the space in the list of individual spaces and chooseRecover Permissions.

You can then chooseManage Permissions, and add any other appropriate permissions to the space.
Requests to recover permissions are recorded in the Confluence audit log.

People with System Administrator permissions are able to manage permissions for all spaces, they do not
need to first recover permissions.

Individual Spaces

These are the current wiki spaces.

Name Key Operations

Dev team DT Manage Permissions
IT Knowledge Base IKB Manage Permissions
Marketing Knowledge base MKE Manage Permissions
Social soc Manage Permissions
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Make a Space Public

If your site is public, and you want to share your space with people who are
not logged in to Confluence (anonymous users), you can make your space
public.

Making a space public does not let you choose who you want to share it with
a public space can be viewed by anyone inside or outside of your
organization.

Related pages:

® Give Access to
Unlicensed Users
from Jira Service
Management

@. In order to make a space public, your administrator must first turn on the global permission for

anonymous access.

This permission doesn't automatically grant anonymous users permission to see any of the spaces

on your site, that is done on a space by space basis.

To make your space public:

1. Go to the space and chooseSpace tools>Permissionsfrom the bottom of the sidebar.

N

ChooseEdit Permissions.

3. Scroll down to theAnonymous Accesssection and select the specific permissions you'd like

anonymous users to have.
4. Save Allto apply the changes.

Anonymous Access

f your Confluence site i

permission, but we r

Own

Anonymous
Select Al

m Cancel

o are not logged in. Anonymous users cen be granted aimost any

All Pages Blog Attachments Comments Restrictions  Mail Space

View Delete Add Delete Add Delete Add Delete Add Delete Add/Delete Delete | Export  Admin

You can't grant space administration or page restriction rights to anonymous users. You can grant Delete
Own, but it will have no effect, as we have no way of knowing who an anonymous user is.

What happens when the site is not public?

If your Confluence administrator turns off anonymous access to your site, users who are not logged in will no
longer be able to see any spaces. However, all logged in users (regardless of their group membership) will
be able to see all spaces that have granted space permissions to anonymous users.

Auditing considerations

There are some additional things to be aware of if you grant theAddpage permissionto anonymous users.

You won't be alerted, when closing the editor or publishing a page, if the only unpublished changes on the
page were made by anonymous users. This means a logged in user may inadvertently publish changes they

were not aware had been made to the page.

The changes themselves are visible in the page, but the usual warning dialog will not appear if the only

people to have made changes were not logged in.
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If there are unpublished changes from both logged in users and anonymous users, the warning dialog will
appear, but only the logged in users will be listed in the dialog. Changes made by all users (including
anonymous) will be included if you view the changes from that dialog.
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Give Access to Unlicensed Users from Jira Service

Management
If you're using Confluence as a knowledge base for Jira Service
Management, you can choose to allow all active users and customers (that Related pages:
is, logged in users who do not have a Confluence license) to view specific
spaces. This can only beturned on via JIRA Service Management. ® Make a Space

Public

When a space is accessible to all active users, you'll see the following
message in the space permission screen.

Permissions Restricted Pages Inspect Permissions

’b Any active user can view this space

Any active user can view pages in this space, including users who don't have
a Confluence license. This was enabled through Jira Service Management so
people can view knowledge articles when raising a help request.

Edit this permission

@This permission overrides all existing space permissions, so any logged in Confluence user will also be
able to see the space (regardless of their group membership).

You canedit this permissionat any time to revoke access to a space, but it can only be re-enabled from Jira
Service Management.

Active users who don't hold a Confluence license have very limited access to Confluence. They can view
pages, but can't like, comment, edit, view the dashboard, use the space directory, see user profiles or
search your full site.

SeeUse Jira applications and Confluence together for more information about Jira Service Management
integration.
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Organize your Space

Here's a few tips that'll help you organize your
space so that everyone can find what they're On this page:
looking for and stay on top of what's important to
them.
® How do | organize content within my

space?
: ) Pages and blogs
-, — e — Configure the sidebar
2 Using labels
@ @ @ @g)w do | keep my space tidy?
i = 5 : . Create a set of guidelines
0 B Use page blueprints
@ O Create from template macro
S Create your own page templates
A . How do | help my team stay on top of

@ _______ ________ ;_”__I____vyhat's important?
s S » = = e g My Spaces
E = Save for later
______ Y sl ' Watch a page, blog or space
b @ @mentions

How do | organize content within my space?

Pages and blogs

Everything you create in Confluence, from meeting notes to retrospectives and everything in between, takes
the form of either pages or blogs.

® Your homepage will be the first thing that visitors to your site see, so to help them find relevant
content, start by curating your homepage with useful macros and including information about what is
in your space. SeeSet up a Space Home Pagefor more information.

® |f you're creating content that is specific mainly to the current timeframe, and isn't going to change
over time, create it as a blog post. Your blog displays as an infinite scroll, so it surfaces the latest
news and visitors just need to scroll down if they're interested in older content.

® |f you're creating content that you want to last, and possibly evolve over time, then create it as a page.
Pages nest, so every page can have its own child pages, which lets you organize your content into
categories and subcategories.

Configure the sidebar

You can Configure the Sidebarto make it easier to navigate through your space.

The space shortcuts section of the sidebar lets you link to important content. You can use this to highlight
pertinent pages within your space, related content from other spaces, or to external content that is relevant
to your space.

The navigation display lists the pages in your space in either a page tree or child pages format. If you only

want some content to be visible in the sidebar, you can hide the navigation display and put the pages you
want to remain visible under Space shortcuts instead.
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4 4 : : :
® s Beginner's guide to Confluence *

F Pages

99 Blog

SPACE SHORTCUTS

F Tag your space with labels
B Groups of users

F] Emergency contacts

PAGE TREE

* Get started in 5 steps

*» When to create a space?

v What should you put in your space?

» Make your content easy to find

The page tree in the sidebar shows the 200 pages closest to where you are. Hit Show all pages, if you want
to see all the pages in a space.

Using labels
Labels are keywords or tags that you can add to pages, blog posts, and attachments.

® Define your own labels and use them to categorize, identify, or bookmark content in Confluence. For
example, if you assign the label ‘accounting' to all accounts related pages on your site, you'll then be

able to:
® Browse all pages with that label in a single space or across the site.

® Display a list of pages with that label.
® Search based on that label.
® Use theContent by Label Macroto create a table of contents for your space that is organized by label

categories.
® Labels aren't exclusive, so you can have as many labels as you want on a page. The page will then
appear under each of those categories. See Use Labels to Categorize Spacesfor more information.

How do | keep my space tidy?

If you have lots of people creating in the same space, things can get messy fast. You can prevent this by
taking a few easy steps.

Create a set of guidelines

® | et your collaborators know about what parent pages to create their child pages under, so no content

gets lost or misplaced.
® Decide on standard labels to add to pages, blogs, and attachments so all content gets neatly

categorized.
® Add a link to this in the Space Shortcuts section of the sidebar so that it's easy to find.

Use page blueprints
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Blueprintsare templates that come with formatting, macros and sample content. You can customize these
Blueprintsfor each space. Everything created from a Blueprint will have it's own index in the sidebar, so for
example if you use the Meeting Notes Blueprint, you can select 'Meeting Notes' in the sidebar to see a list of
all the meeting notes in your space.

Create Filter Help

Select space Beginners guide to Confluence Parent: Baginners guide to Conflu..

ﬁ' Deacision
4 Record important project decisions and
communicate them with your team.

DACI decision
Define the roles and respansibilities for
making high-impact or high-risk decisions.

&

Experiance canvas
Make sure your work is user-centered,
technically sound, and makes sense for the

Haalth monitor

Fila list
Upload, preview and share files with your
team.

How-ta article

Keep track of your project or team's health. Provide step-by-step guidance for

completing a task.

Jira raport

Fmamar imlmata

Meating notes

Nen Imfoommnting fm mmais bm smned B Al Plam s meanbioen ansl sbase satan s

Add or customise templates for the salected space

Create from template macro

Make things simpler for other contributors by using the Create from Template Macro. The Create from
Template Macro lets you put a button on a page that links to a specific template of your choice. When the
button is clicked, the macro opens the editor, ready to add a new page, and adds content to that page based
on the given template.

Create your own page templates
Createyour owntemplatesfor any content that you want formatted the same way every time. For example, if
you have to create a regular report tracking the same criteria, create a template with headings, variable

dates, tables, and spaces for any graphics, so that each time all you have to do is input the new data instead
of creating the whole report from scratch.

How do | help my team stay on top of what's important?

If you've got a lot of content on Confluence, staying on top of everything may seem a little daunting but
these features will help your team save and track all the content they care about.

My Spaces

Add any spaces that you want to be able to navigate to easily to your list of ‘My Spaces'. This list can be
found under your dashboard and in the Space Directory, and you can also use theSpaces List Macroto
display it on a page or blog.

To add a space to your list of 'My Spaces', either navigate to that space or find it under the Space Directory,
and select the star icon next to the Space Name. To remove it from the list, just select the star icon again.
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MY SPACES ALL

.‘: Beginner's guide to Confluence
# T Knowledge Base
" Dev team

k! Teams in Space

Save for later

If you only want links to certain pages or blogs rather than a whole space, you can choose Save for later and
these will appear on your dashboard and under your profile. You can use the Favorite Pages Macroto
display a list of all of everything you've saved for later.

& Edit ¥¥ Save for later ® Watch <5 Share

Watch a page, blog or space

If you want to keep track of all the changes made to a page, blog, or space, you can also watchthem.
Watching any content means that you will receive email notifications for all edits, deletions, attachments or
comments made to that content.

® To watch a page, navigate to the page you want to watch, then choose Watch > Watch page, or if
you want to watch the whole space, select Watch all content in this space.

® To watch a blog, navigate to that blog and choose Watch this blog.

® To stop watching something, deselect the relevant checkbox.

You can also manage watchers for your own space. This is useful when, for example, you're creating a new
project, and want the team members on that project to stay notified of its progress. Go to any page in that
space and choose Watch > Manage Watchers, then add or delete any names under 'Watching this space'.

# Edit v¥ Save for later © Watching < Share

You are watching this page

Receiving email updates about changes to this
page.

Watch page

Watch all content in this space

Manage Watchers

@mentions
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Use @mentions for any work where you need someone else's input or want to assign someone a task.
Mentioning someone works like a tag; they'll immediately receive a notification that they've been mentioned,
and can click through to that page or blog. If you mention someone when creating a task, it'll assign that task
to them and they'll also be able to find it under their profile.

You can use this in place of emails if you want someone to look something over, add in additional
information, or approve anything, simply put that work on Confluence and assign it to them as a task. They'll
be able to make any changes or comments within Confluence and let you know when they're done by
mentioning you back.

Created in 2021 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Set up a Space Home Page

When you create a space, Confluence automatically

creates a home page for that space. Spaces On this page:
created with a blueprint come with a ready-made

home page populated with useful macros and

sample content specific to the blueprint's use case.

However, even if you've started with a blank space,
you can still customize your home page to make it

Create a kickass home page

Top macros for common types of spaces
Set up your personal space home page
Set another page as your home page

easier for everyone using that space to navigate
their way around and find useful content. Related pages:

® QOrganize your Space

Create a kickass home page

What is this space about?

Your home page is the first page visitors will see when they visit your space, so it helps to include
some information about what the space is about, and what you're working on. You can use the Info,
Tip, Note, and Warning Macrosto create a colored box in which to put this information.

What is in this space?

You can use the Content Report Table Macroto create a table of contents for your space. You can
also set this macro to only display content with a particular label, so if you would like only some
content to display, you can do this by adding that label to only those pages and blogs you want listed
on your home page.

Organize your space with labels

You can organize content in your space with labels, so that for example, if you have a Learning and
Development space, you can create different labels for online learning resources, upcoming
workshops, and training strategy. You can then use the Labels List Macroto create a list of those
labels to make it easy for visitors to your space to find the content relating to each of those topics.

Add a search box so that it's easy to find content within your space
The Livesearch Macroallows you to add a search box to a Confluence page, and you can set it to only
find content within your space.

Keep everyone updated about the latest changes within your space

If it's important for your visitors to know about the latest changes to your space, you can use the Rece
ntly Updated Macroto display a list of the most recently updated content. You can set the space
parameter to show this for just your space, or, if you have related spaces, to show the most recently
updated content across all of those spaces as well.

Using Jira? Create and display your Jiraissues on Confluence

If your Confluence site is connected to a Jira application, you can both create and display your Jira
issues without having to leave Confluence using the Jira Issues Macro. You can connect Confluence
to any Jira application, including Jira Software and Jira Service Management.
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Top macros for common types of spaces

Team Spaces:

® Introduce the team: The User Profile Macrodisplays a short summary of a given Confluence user's
profile with their role, profile photo and contact details.

® Share news and announcements with your team: The Blog Posts Macrodisplays a stream of your
latest blog posts so your team can easily see what's been going on.

Knowledge Base:

® Have external content that you need on your page? Embed online videos, slideshows, photo
streams, and more, directly into your page with the Widget Connector Macro.

® Put your own multimedia content onto the page: The Multimedia Macroembeds attached video,
animation, and other multimedia files on a Confluence page.

® Create an index of all your content: The Page Index Macrocreates a hyperlinked alphabetical index
of all page titles within the current space.

Planning/Project:

® Keep track of everyone's tasks: Use the Task Report Macroto display a list of tasks on a page.
Filter the tasks by space, page, user, label, created date and more.

® Is your project on track? The Status Macrodisplays a colored lozenge (a rounded box) that is useful
for reporting project status. You can choose the color of the lozenge and the text that appears inside

the lozenge.
® |et everyone see where you're going: The Roadmap Planner Macrocreates simple, visual timelines

that are useful for planning projects, software releases and much more.
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Using Macros

1. From the editor toolbar, choose Insert T = > Other Macros
2. Find and select the required macro

Speed it up with autocomplete: Type{and the beginning of the macro name, to see a list of suggested
macros. In this example we're inserting the cheese macro.
{che

Macro suggestions

Cheese

Open macro browser

To edit an existing macro: Click the macro placeholder and choose Edit. This will open the macro
details, so you can edit the macro parameters.

Edit Remove

Set up your personal space home page

Whether you're using your personal space as a sandbox to draft and test content, a portfolio to show off
what you're working on, a home base to navigate to your content in other spaces, or something completely
different, these are some macros that should help you use your space more effectively.

® Use the Favorite Pages Macroto create a list on your home page of all the pages you've saved for
later, so you can easily navigate back to any of them.

® Use the Content by User Macroto keep track of all the current pages, comments and spaces you've
created so you can find everything you've been working on in one place.

® Use the Task Report Macroto keep track of all tasks assigned to you, and tick them off as you finish
them.

® Use the Recently Updated Dashboard Macroto keep track of all the content across your Confluence
site that you're interested in the Dashboard lets you choose which spaces, users, blogs, pages or
files you would like to keep updated about.

Set another page as your home page

If at any point you decide that you would like another page within your space to be your home page, you can
easily change this from the Edit Space Details tab.

To edit a space's detalils:
1. Go to the space and chooseSpace tools>Overviewfrom the bottom of the sidebar.

2. Choose Edit Space Details.
3. Enter the page you want use in the Home page field then choose Save.
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Space Details Delete Space

Edit Space Details

Name:  Beginner's guide to Confluence

Description: A few simple tips to help you on
your way to becaming a Confluence
expert.

Rl g

Status: Current

Home page: Beginner's guide to Confluence Homr

The page that displays when users navigate to this space.

o

i.You can change the home page, name and description of your space, but you are not able to change the
space key.
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Use Labels to Categorize Spaces

If you've got lots of related spaces, you can use labels to group them
together into categories in theSpace Directory.

For example, if you're in an IT team who work on a number of projects,
each in a different space, you could label each space 'IT-projects-open'.
Then in the Space Directory you could select IT-projects-open to see all
your current IT project spaces.

You can add as many space categories to a space as you need, so that if,
for example, two different teams are working on a project together, you can
add labels for both teams and space will appear under both categories.

Labels are easy to add or remove, so if your needs change, you can always
recategorize your spaces.

Categorize a space

You need space administrator permissions to add categories to a space.

On this page:

® Categorize a space
® View spaces in a

category
Remove a space
from a category
Search within a
space category

Related pages:

Add, Remove and
Search for Labels

1. Go to the space and chooseSpace tools>Overviewfrom the bottom of the sidebar

2. ChooseEditnext toSpace Categories.

3. UnderSpace Categories, enter your category name and chooseAdd.

Alternatively, choose a category in the list of Suggested Space Categories.

4. ChooseDone.

Add a space description

Help make it easier to find the right space within a category by adding a description to your space:

1. Go to the space and chooseSpace tools>Overviewfrom the bottom of the sidebar.

2. Choose Edit Space Details.

3. Under the Description field, type a short description to tell visitors what your space is about, then

choose Save.

View spaces in a category

To see what spaces are in a category, chooseSpaces > Space directoryin the Confluence header, then

select one of the categories from the list.

Space Directory

marketing bas0s

CATEGORIES ) ' i :
Hint: Your space administralor can organise spaces into categories, Learn maore.

Knowledge-bases

Al Spaces Knowledge-bases

Site Spaces Space Description Categaries

S P 4

Personal Spaces é IT Knowledge Base knowledge-
. bases

My Spaces

Archived Spaces z Marketing Knowiedge base This is the space for all things knowledge-

®y Create Space
s p

You can also view spaces by category byusingthe Spaces List Macro and filtering by category.
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@ Head to My Spaces in the Space Directory to see all your favorite spaces. When viewing a space,
you can choose the star icon next to the space title in the sidebar to add it to My Spaces so that it's
easier to find later.

Remove a space from a category
1. Go to the space and chooseSpace tools>Overviewfrom the bottom of the sidebar

2. ChooseEditnext toSpace Categories.
3. UnderSpace Categories, choose the x icon next to each category that you want to remove.

Space Details Delete Space

Categories

Space Categories will appear inside the categories tab on your dashboard and as
tabs in the space directory. They can be used to group together related spaces.

Labels
help X knowledge-bases x

Add

i.If you remove all spaces from a category, the category will no longer appear in the Space Directory.
There's no way to bulk remove a category, but you can choose the category in the Space Directory to find all
the spaces it appears on, and then remove it from each space.

Search within a space category
You can search for content within a specific space category using the search filter.
To search within a Confluence space category:
1. Click the search field in the top-right of Confluence to open the search panel.
2. Click the Space category filter on the left.

3. Start typing the category name and choose from the list of possible matches.

Learn more about searching Confluence.
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Customize your Space

Make your space stand out from the crowd by Related pages:
customizing its appearance.

o ® Changing the Look and Feel of Confluence
If you have space adminprivileges, you can change
the color scheme for your space, add your own ® Styling Confluence with CSS
space logo,choose what shows up in your space's
sidebar,oruse Atlassian Marketplace themes to

change the whole look of your space.

® Configure the Sidebar

® Edit a Space's Color Scheme
® Apply a Theme to a Space

® Customize Space Layouts
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Configure the Sidebar

If you have administration permissions for a space,

you can customize the space's sidebar to have its On this page:
own logo, change the way the hierarchy is

displayed, and add shortcut links to help navigate to

important content quickly. ® Change the space name and logo

® Configure the sidebar links
To start configuring the sidebar, choose Space ¢ Change the navigation display options
tools > Configure sidebar. ® Adding custom content to a sidebar

Related pages:

Change the space name and logo * Edit a Space's Color Scheme
® Organize your Space

To change the space name:

1. Choose # next to the space hame.
2. Type in a new space name andSave.

<4 R
o & Beginner's guide to Confluence I.‘—-o

e—" B Pages ©

99 Blog O]

Space shortcuts @"—o

F Tag your space with labels 0

# Groups of users ]

-+ Add link

Navigation display options ©)

Child pages
© Page tree
Done

1. Logo - change the space name and logo
2. Reorder - drag to reorder shortcuts
3. Hide - hide or show pages, blogs, shortcuts or navigation display options.

To change the space logo:

Choose the # next to the space name.

ChooseUpload an image.

Select an image from your computer.

Adjust the size of the image to fit within the highlighted circle.
ChooseSave.

arwdppE

Things you should know:

® Space logos are 48px x 48px. Logos smaller than these dimensions will be centred with whitespace
around them.

® You can only change the space logo for a site space. For your personal space, your profile picture is
used as the space icon.

Configure the sidebar links
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® Choose the icons to show or hidepages,blogs,shortcutsornavigation options.
For example, if you want your space to be used primarily as a blog you can hide the 'Pages’ link.

® Add-ons such asTeam Calendars for Confluence Servermay add other links in this section of the
sidebar and you can also show or hide these.

® ChooseAdd linkto add a shortcut link to the sidebar. This could be a link to an important page for
your team, or to an external site.

® Drag links to reorder themwithin each section (you can't move a link from one section to another).

Change the navigation display options
® ChooseChild pagesto see the current page and its children in the sidebar.
® ChoosePage treeto see the page tree for the entire space, expanded to the current page.
® You can also choose to completely hide the navigation display options and instead add the pages you

want to be visible as shortcut links. Alternatively, you can remove the sidebar navigation altogether
and use a Page Tree MacroorChildren Display Macro on your homepage for navigation instead.

Adding custom content to a sidebar

You can further customize a sidebar using wiki markup to add custom content.

To add custom content to your sidebar:
1. Go to the space and chooseSpace tools>Look and Feelfrom the bottom of the sidebar.
2. Choose Sidebar, Header and Footer.

3. Enter your custom content in theSidebarfield.

The sidebar, header and footer fields all use wiki markup, check ourguide to wiki markupfor help, or check
out some common customizations below.

To add a search field to the sidebar add the following wiki markup for a search macro in the Sidebar field.
For the Livesearch Macro macro:

{livesearch}

For the Page Tree Search Macro macro:

{ paget r eesear ch}

To add a panel with some custom content to the sidebar add the following wiki markup for thePanel
Macroin the Sidebar field:

{panel } This is some custom content to appear in the sidebar{panel}

To hide the default page tree and add your own, with additional parameters:
1. Add the wiki markup for the Page Tree Macro in the Sidebar field.
The following example includes parameters to expand the top three levels of the page tree by
default and include an Expand All and Collapse All link above the tree.

{paget ree: r oot =Page Nane| st art Dept h=3| expandCol | apseAl | =t r ue}

2. Goto Space Tools > Configure sidebar.
3. Use the Show and Hide icons to hide the default page tree from the sidebar.
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Edit a Space's Color Scheme

Spaces inherit the global color scheme by default, but if you have admin

O . i . . Related pages:
permissions for a space, you can jazz it up with your very own customizable

color scheme. ® Configure the
Sidebar

To change the color scheme for a space: * Apply a Theme to
a Space

1. Go to the space and chooseSpace tools>Look and Feelfrom the
bottom of the sidebar

2. ChooseColor Scheme

3. ChooseSelectnext to a scheme listed underCustom Color Scheme
(if not already selected)

4. ChooseEdit -

5. Enter standard HTML/CSS2 color codes or use the color-pickeri= tto
choose a new color from the palette provided

Customizable Elements
The color scheme allows you to edit the colors of Ul elements including the top bar, tabs and backgrounds.
Some Ul elements below are for specific themes, and color changes may not take effect for other themes.

Top Bar- the top navigation bar background

Top Bar Text- the text on the top navigation bar

Header Button Background- buttons on the top navigation bar (e.g. Create button)

Header Button Text- the text on buttons on the top navigation bar

Top Bar Menu Selected Background- background color of top navigation bar menu items when
selected (e.g. spaces)

Top Bar Menu Selected Text- text color of top navigation bar menu items when selected

Top Bar Menu Item Text- text on top navigation bar drop down menus (e.g. help or cog)

Menu Item Selected Background- highlight color on top navigation bar drop down menu items
Menu Item Selected Text- text color on highlighted top navigation bar drop down menu items
Search Field Background - the background color of the search field on the header

Search Field Text - the color of the text in the search field on the header

Page Menu Selected Background-the background color of the drop down page menu when selected
Page Menu Item Text-the text of the menu items in the drop down page menu

Heading Text-all heading tags throughout the space

Links- all links throughout the space

Borders and Dividers- table borders and dividing lines
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Custom Colour Scheme
A custom colour scheme which can be edited.
H B N B BN BEBEE s
Edit
The fallowing colours can be customised for this colour scheme.
7op Bar [ #004880 @
Top Bar Text #DEEBFF o]
Header Button Background . #00BSFF &
Header Button Text #FFFFFF [+ ]
Top Bar Menu Selected Background . RGBA(9, 30, 66, 0.48) &
Tap Bar Menu Selected Text #DEEBFF ]
Top Bar Menu Item Text . #172B4D EJ
Menu Item Selected Background #EBECFO 1]
Menu llem Selecied Text . #172B4D &
Search Field Backaround . RGBA(9, 30, 6&, 0.48) 4]
Search Field Text #DEEBFF &
Page Menu Selected Background #FAFSF7 &
Page Menu ltem Text . #17284D [+ ]
Heading 'm:r. #172B4D i ]
inks [ #o0s2ce ]
Borders and Dividers #FFFFFF @
Reset Cancel

(® Handy Hint

If you mess things up, just choose Reset then try again.
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Apply a Theme to a Space

Themes are used to change the appearance of your space. Your

Related pages:
Administrator can download and install themes fromThe Atlassian pag

Marketplace. ® Applying a Theme
to a Site

Once a theme is installed it can be applied to the whole site or to individual ¢ Customize your

spaces. Space

To apply a theme to a space: * Edita Space's

Color Scheme

1. Go to the space and chooseSpace tools>Look and Feelfrom the * g%gt')%urre the
bottom of the sidebar

You'll needSpace Admin permissionsto do this.

ChooseThemesand select a theme option.

3. ChooseConfirm.

n

What is the global look and feel?

When a new space is created, whichever theme is applied to the whole site will be applied by default to the
new space. This is the global look and feel, and any changes made globally will flow through to all spaces
that inherit the global look and feel.

If a space has its own theme applied, or if changes have been made to customize the look and feel of the
space, it will no longer inherit changes from the global look and feel.

If you want to go back to inheriting the global look and feel chooseGlobal look and feelfrom theThemespag
e.
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Documentation theme migration FAQ

Aspreviously announced, the documentation theme is not available in Confluence 6.0. We know you'll have a lot
of specific questions, so we've created this FAQ to help you prepare for upgrading to Confluence 6.0.

If you have further questions, you can ask them at the bottom of the page and we'll do our best to provide an
answer.

What does the default theme look like?

How can | check if | am using the documentation theme in my space?
How can | check if the documentation theme is being used anywhere in my site?
What will happen to my theme customizations during the upgrade?

Will my space break after the upgrade?

Can | add custom content to the sidebar, header and footer globally?
Can | still use macros in my sidebar, header or footer?

Where should | add custom content to the sidebar, header or footer?
How do I turn off the Pages and Blogs shortcuts at the top of the sidebar?
Can | edit the default theme's sidebar globally?

| want to see the page tree, not child pages. how do | do this?

Where is Space Administration and Space Operations?

Do | have to use wiki markup in the sidebar, header, and footer?

Can | hide or change the space logo appearance?

Can | hide the built in page tree and insert my own?

How can | make my page titles wrap in the sidebar?

Can | change the order in which things appear in the sidebar?

Can | still use the space jump macro?

Why don't child pages appear below the page?

Can | restrict search to just this space?

How do | view the pages in my space alphabetically?

What will happen if | import a space that uses the documentation theme?

What does the default theme look like?

Here's an example of the documentation theme, and default theme with the same custom content side by side:

= XConfluence Spaces - Pecpis Browse - | Creats

Not sure where to start?

Sample Spact
Raead the Geliing Started guice Trst. San‘lple Space Home
3 Meskng nates B Croatd by Fach Admin [Aominseion. st mocited 2 minaes ago
3 Project Romdmap

* Sumvey rests

= XConfluence Speces- Pecpls  Greate

- Fages @
Sample Space

1.
2.

Sample Space Home
& Pages & 15

reaied by Rch Adenin JAdminisinrion, lnst modified 8 minuies ago

N Blog
SPACE SHORTCUTS
1] Mesting notes

Mot sura where to start?

Read tha Gatting Stared guida first

PAGE TREE
+ Projact Rosomap
' Mesting rotes

* Survey resulls

Documentation theme: with custom sidebar content.
Default theme: with the same custom content in the sidebar.

How can | check if | am using the documentation theme in my space?
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The easiest way to check whether your space is using the documentation theme is to look for aBrowse menu in
the header, near the Create button. (If you're using the default theme already, you'll see a Space Tools menu at
the bottom of the sidebar instead.)

How can | check if the documentation theme is being used anywhere in my site?

There's no simple way to see a list of spaces using the Documentation theme in Confluence itself, however if
you have a very large site, your Confluence Administrator can use the following query to get a list of spaces
directly from the database.

SELECT *

FROM BANDANA B, SPACES S

VWHERE B. BANDANAKEY=' at | assi an. conf | uence. t hene. setti ngs'
AND S. SPACEKEY=B. BANDANACONTEXT

AND B. BANDANAVALUE LI KE (' %glocunent ati on% )

ORDER BY S. SPACENAMNE;

This query will only find spaces that are explicitly using the documentation theme. It doesn't include spaces
using the global look and feel (these spaces automatically change when you change the Site Theme, you wont
need to change the theme space by space).

What will happen to my theme customizations during the upgrade?

During the upgrade we'll automatically turn on the default theme for any spaces that currently use the
documentation theme. If you've customized the documentation theme (by adding wiki markup to the sidebar,
header or footer) we'll take this wiki markup and drop it into the sidebar, header and footer in the default theme.

The default theme adds some new sections to the sidebar, such as links to pages, blogs and space shortcuts.

You can choose to hide these - head to Space Tools > Configure Sidebar and use the “='button to hide any
items you don't want to see.

Will my space break after the upgrade?

This depends on the amount of customization you have. In most cases your space sidebar may look a little
different but the changes shouldn't be dramatic.

If you've used CSS to change the appearance of your space (either in the space stylesheet or by using the
Adaptavist Content Formatting macros like{style} and {div} in the sidebar, header, or footer of the
documentation theme), you may need to make a few changes to some class names in your CSS to get your
space looking right. For example, if you specified#spl i t t er - si debar in the doc theme, you'll need to use.
acs- si de- bar for the default theme.

If you have customized default theme layouts through the Confluence Ul, you may find that your space looks
strange or broken when the default theme is re-applied to spaces previously using the documentation theme.

If you experience problems, you'll need to reset the broken layouts.

This method will only work if you have more than one theme available in your site. You'll need System
Administrator global permission to do this.

1. Switch to another theme temporarily.
If you're unable to use the space navigation, use this URL, replacing YOURSPACEKEY with the space
key for the space.

http://<yoursite>/spaces/ chooset hene. acti on?key=YOURSPACEKEY

2. In the space administration options go to Layouts (if available) or use the following link, replacing YOU
RSPACEKEY with the space key for the space.

http://<yoursite>/spaces/|istdecorators. acti on?key=YOURSPACEKEY
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3. Choose Reset Default next to any template that have been customized.
4. Return to the Themes page and try applying the default theme again.

Layouts can also be customized for the entire site - head to E> General Configuration > Layouts if you
need to reset the layout for the entire site.

If you're unable to reset the layouts via the Confluence Ul, you can remove the affected layouts directly in
the database. Be sure to take a full database backup before you try this.

First, use the following query to identify customized layouts:

Sel ect *
FROM DECORATOR
ORDER BY SPACEKEY

Then, you can selectively remove records for spaces that are affected.

Can | add custom content to the sidebar, header and footer globally?

Yes. Head toﬂ> General Configuration>Sidebar, Header and Footer. All spaces that use the global look
and feel will inherit your custom content. Any custom content added to the sidebar, header and footer in a
particular space will override any custom content added globally.

Can I still use macros in my sidebar, header or footer?
Yes! If a macro worked correctly in the documentation theme it'll work in the default theme too.
Where should | add custom content to the sidebar, header or footer?

You can add custom content to the sidebar, header and footer in each space individually (Space Tools > Look

and Feel > Sidebar, Header and Footer) or globally (E> General Configuration>Sidebar, Header and
Footer).

Confluence displays global custom content in all spaces, except where a space has its own custom content
defined (space custom content overrides global custom content). This behavior applies field by field, so a space
can display a combination of custom content. For example you could define the content of a footer globally, and
content of a header in each space individually, or only in some spaces.

How do I turn off the Pages and Blogs shortcuts at the top of the sidebar?

Go toSpace Tools>Configure Sidebarand use the"='icons to hide any items you don't want to see.

Can | edit the default theme's sidebar globally?

No. You can add custom content to the sidebar globally, but showing and hiding sections of the sidebar, setting
space logos, and adding shortcut links are done on a space by space basis.

I want to see the page tree, not child pages. how do | do this?

Head toSpace Tools>Configure Sidebarand selectPage Treein the navigation options. The default for all new
spaces is Page Tree.

Where is Space Administration and Space Operations?
Instead of choosing between Space Operations and Space Administration, the documentation theme has a

single Space Tools menu that lets you jump right to Permissions, Content Tools, Look and Feel, or
Integrations.

Old Space Operations location New Location in the sidebar

Browse > Pages Pages on the sidebar or Space Tools > Reorder pages
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Browse > Blogs

Browse > Labels

Browse > Space Operations >
Space Details

Browse > Space Operations >
Orphaned Pages

Browse > Space Operations >
Undefined Pages

Browse > Space Operations >
Attachments

Browse > Space Operations >
PDF, HTML, XML Export

Browse > Space Operations >
RSS Feeds

Browse > Space Operations >
Watch this space

Browse > Space Operations >
Watch this blog

Browse > Space Operations >
Remove from My Spaces

Browse > Space Admin > Space
Details

Browse > Space Admin > Space
Categories

Browse > Space Admin >
Templates

Browse > Space Admin > Delete
Space

Browse > Space Admin > Trash

Browse > Space Admin >
Permissions

Browse > Space Admin >
Restricted Pages

Browse > Space Admin >
Application links

Browse > Space Admin > Themes

Browse > Space Admin > Color
Scheme

Browse > Space Admin > PDF
Layout

Blogs on the sidebar

Click a label on any page, then use the Q- menu to see all
labels, popular labels or pages from other spaces

Space Tools > Overview

Space Tools > Content Tools > Orphaned Pages

Space Tools > Content Tools > Undefined Pages

Space Tools > Content Tools > Attachments

Space Tools > Content Tools > Export

Space Tools > Content Tools > RSS Feeds

Pages > Watch this space (or use the Watch button on any page)
Blogs > Watch this blog (or use the Watch button on any blog post)
Use the W icon in the sidebar (or in the space directory)

Space Tools > Overview

Space Tools > Overview

Space Tools > Content Tools > Templates

Space Tools > Overview > Delete Space

Space Tools > Content Tools > Trash

Space Tools > Permissions
Space Tools > Permissions > Restricted Pages
Space Tools > Integrations > Application Links

Space Tools > Look and Feel > Themes

Space Tools > Look and Feel > Color Scheme

Space Tools > Look and Feel > PDF Layout
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Browse > Space Admin > PDF Space Tools > Look and Feel > PDF Stylesheet

Stylesheet

Browse > Space Admin > Space Tools > Configure Sidebar then choose the edit icon on the
Change Space Logo space logo

Browse > Space Admin > Hipchat = Space Tools > Integrations > Hipchat
Integration

Do | have to use wiki markup in the sidebar, header, and footer?

Yes. Our main focus when adding this feature was to help people move from the documentation theme to the
default theme with a minimum of effort. Keeping these fields as wiki markup means that your existing
customizations can be pasted straight in.

Can | hide or change the space logo appearance?

You can upload any image to use as your space logo, but you can't change how it appears in the sidebar (it's
always round and always at the top).

Can | hide the built in page tree and insert my own?

Yes! If you want to have complete control over how the page tree appears in your sidebar you can hide the built
in page tree, and then add aPage Tree macro{ paget r ee} in the sidebar custom content.

How can | make my page titles wrap in the sidebar?

Page titles do not wrap in the sidebar of the default theme (regardless of whether you're using the built in page
tree or have added a { { paget r ee} } macro as custom content). There's no way to change this.

Can | change the order in which things appear in the sidebar?

You can change the order of some items in the sidebar, such as the shortcuts, but the order of the sections
themselves can't be changed. Anything that has a = icon can be moved.

Custom content appears above the page tree. You have the option to hide the built in page tree, and then add it
back in the custom content area using wiki markup. This can be useful if you want more control over the order
of the page tree and your custom content.

Can | still use the space jump macro?

No, the space jump macro was provided by the documentation theme and will not be available once the
documentation theme is removed. If you've used this macro on a page or in the header or footer of a space, it
will show the following error after the upgrade unknown macro: {spacej unp}.

To find out whether the Space Jump macro is used on any pages in your site, entermacr oNane: spacej unp
into the search bar. All pages containing the macro will be returned (it won't search the sidebar, header or footer
unfortunately).

Why don't child pages appear below the page?

The default theme does not list child pages below the sidebar, but you can achieve a similar result by adding a C
hildren Display macro to the footer.

Can | restrict search to just this space?
No, that is one of the features we removed with the documentation theme.

One workaround is to add a Livesearch macro to the sidebar or space homepage. Use@el f in the spaces
parameter to restrict the search to the current space.

How do | view the pages in my space alphabetically?

The default theme does not have an option to view all pages in your space alphabetically.
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What will happen if | import a space that uses the documentation theme?

You should have no problems importing the space, but it will have the default theme applied and any wiki
markup customization in the theme will not be automatically migrated to the default theme. Before exporting the
space you should copy the wiki markup contents of the sidebar, header, and footer fields and keep it so that you
can add it back in manually after you've successfully imported your space.
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Customize Space Layouts

You can modify Confluence's look and feel by

editing the layout files. This page tells you how to Related pages:

customize the layout files for a space. You'll need

the system administratorglobal permissionplusspace ¢ Customize your Space
administratorpermission for that space. ® Apply a Theme to a Space

® Styling Confluence with CSS
People with system administrator permissions can
also customize the layout of the entire Confluence
site. For more information, seeCustomizing Site and
Space Layouts. Site layout customizations modify
the default layout of all spaces in the Confluence
site.

Any space layout customizations will override the
equivalent site customizations.

-

(D If you modify the look and feel of Confluence by following these instructions, you'll need to update
your customizations when you upgrade Confluence. The more dramatic the customizations are, the
harder it'll be to reapply your changes when upgrading. Please take this into account before
proceeding with any customizations.

For more information on updating your customizations, please refer to Upgrading Customized Site
and Space Layouts .

&

Confluence is built on top of the Open Source SiteMesh library, a web-page layout system that provides a
consistent look and feel across a site. SiteMesh works through 'decorators' that define a page's layout and
structure.

To edit the layout of Confluence, you will need to modify these decorator files. A decorator file is a .vmd file
and is written in a very simple programming language called Velocity. Learn more about Velocity. Once you
become familiar with Velocity, you can edit the decorator files to personalize the appearance of Confluence.

The decorator files in Confluence are grouped into the following categories:

® Site layouts: These are used to define the controls that surround each page in the site. For example,
if you want to make changes to the header and the footer, you will need to modify these layouts.

® Content layouts: These control the appearance of content such as pages and blog posts. They do
not change the way the pages themselves are displayed, but they allow you to alter the way the
surrounding comments or attachments are shown.

® Export layouts: These control the appearance of spaces and pages when they are exported to
HTML. If you are using Confluence to generate a static website, for example, you will need to modify
these layouts.

Learn more about using decorators.
To edit a decorator file:

1. Go to the space and chooseSpace tools>Look and Feelfrom the bottom of the sidebar
2. Choose Layout(Layout is displayed only if you are a Confluence system administrator.)
You'll see a list of the layouts for the space
3. Click Create Custom to edit the default vmd file
This will open up the vmd file in edit mode. If you only want to view the vmd file, clickView Default.
4. Make any changes and click Update


http://velocity.apache.org/
http://wiki.sitemesh.org/wiki/display/sitemesh/Home
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Content Layouts

Content layouts contraol the appearance of content such as pages and blog
posts: they don't change the way the pages themselves are displayed, but they
allow you to alter the way the surrounding comments or attachments are shown.

Decorator Operations

Space Layout < default > - Create custom -
Controls how a space is displayed. View Default

Page Layout < default > - Create custom -
Controls how a page is displayed. View Default

Blog Post Layout < default > - Create custom -
Controls how a blog post is displayed. View Default
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Archive a Space

Archiving a space is useful when you have content that is no longer

relevant, but you still want the option of accessing it at a later date. On this page:
Archived spaces are less visible, but still available on your site. Archiving a
space is easy to undo you can make a space current again at any time. * Archive a space
® The effect of
Archive a space archiving a space
® Spaces
1. Go to the space and chooseSpace tools>Overviewfrom the bottom ® Pages

® Change a space
from archived to
current

of the sidebar
2. ChooseEdit Space Details.
3. SelectArchivedin theStatusdropdown menu.

4. Ch .
ChooseSave Related pages:

® Delete a Space

® Export Content to
Word, PDF, HTML
and XML

The effect of archiving a space

Spaces
If a space is archived, that space:

Won't appear in the Recent spaces section of the search panel.

Won't appear in search results, unless you select Search archived spaces.

Won't appear in advanced search results unless you selectSearch archived spaces.
Won't appear on the Spaces dropdown menu.

® Won't appear in the general spaces lists in theSpace Directory, but will instead appear under theArch
ived Spaceslist. It will, however, still appear under any categories it was labeled with.

® Won't show up in activity streams when updated.

®* Won't appear on your dashboard.

Pages
Pages within an archived space will appear in a few places.
If youviewa page within an archived space, that page will appear in:

® The Recently visited section of the search panel.
® TheRecently viewed pagesmenu.

If youedita page within an archived space, that page will appear in:

® Activity streams
® TheRecently updated macro.

Pages within an archived space won't appear in search results, unless you selectSearch archived spaces.
These functions remain available for archived spaces:
® You can view the content as usual, by following a link or typing in a URL belonging to the archived
space.

® You can edit the content as usual, as determined by thespace permissions.
® RSS feeds, watches andnotifications remain active.
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@Archiving a space has no effect on search results of external search engines. For example, a public space
will still appear in Google search results.

Change a space from archived to current
Through the space directory:

Go toSpaces>Space directoryin the header.
ChooseArchived Spaceson the left.

Find your space and click the@on the right.

ChooseEdit Space Details.

Change theStatus from 'Archived' to 'Current' and hit Save.

O WNR

Through the archived space:

1. If you know thespace key, you can navigate straight to the archived space -htt p: // yoursite
/ di spl ay/ SPACEKEY

2. ChooseSpace tools>Overviewfrom the bottom of the sidebar.

3. Choose Edit Space Details.

4. Change theStatusfrom 'Archived' to 'Current' and hitSave.

Space Details Delete Space

Edit Space Details

Name: Beginner's guide to Confluence

Description:

.

Status: | v Current : '

Archived

Home page: | Beginner's guide to Confluence Hom

The page that displays when users navigate to this space.

o
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Delete a Space

Deleting a space permanently removes the space and all of its contents,
including any calendars and questions linked to that space. Only someone
withspace admin permissionscan delete that space.

i.Deleting a space is permanentit does not go to the trash and cannot be
undone.

If you're unsure about deleting a space,create anXML export of the space
as a backup before proceeding. You can then restore the space from the
XML export file if you need to.

To delete a space:

1. Go to the space and chooseSpace Tools>Overviewfrom the bottom
of the sidebar.

2. ChooseDelete Space.

3. ChooseOK.

Related pages:

® Archive a Space

® Export Content to
Word, PDF, HTML
and XML

Space Details Delete Space

attachments and blogposts)

WARNING

cannot be retrieved. It will be gone forever.

Knowledge Base?

OK Cancel

Deleting a space will delete all its content (including pages, comments,

This operation cannot be undone. Once the space is deleted, it

Are you sure you want to delete this space with space key IKB and name IT

G} Members of the conf | uence-adm ni st rat or s group can also delete spaces, including personal

spaces.



Export Content to Word, PDF, HTML and XML

You can export all or part of a Confluence space to various formats,

including Microsoft Word, HTML, PDF and XML. On this page:
To use the space export functionality, you need the 'Export Space’ ® Export single
permission. See the guide tospace permissions. pages to PDF

® Export single
Export single pages to PDF pages to Word

® Export multiple
If you need to send content to people who don't have access to Confluence, pages to HTML,
you can export a single page or blog post as a PDF. XML, or PDF

® Customizing the
If you've got permission to view the page in Confluence, you'll be able to appearance of
export it in this way; go to the page and choose*** (Tools)>Export to PDF. PDF exports

® Migrating content
Only published content is exported. This means you can create PDF to Confluence
exports even while people are still working on the page. Cloud
When you export a single page to PDF, the PDF stylesheet customizations Related pages:

are applied, but any PDF layout customizations are not. To make your PDF
layout customizations apply to a single page exported to PDF, you'll need to
use the 'multiple page' method described below to export the single page.
SeeCustomize Exports to PDF.

® Customize Exports
to PDF
® Restoring a Space

Export single pages to Word
You can also choose to export single pages to a .doc file that can be opened in Microsoft Word.

If you've got permission to view the page in Confluence, you'll be able to export it in this way; go to the page
and chooseTools>Export to Word.

Only published content is exported. This means you can create Word exports even while people are still
working on the page. Also, only the first 50 attached images will be included in the export. See the notes
below for more information.

Note that due to the format of this file, it can only be opened in Microsoft Word and is not compatible with
other applications such as Open Office, Libre Office or Google Docs.

Export multiple pages to HTML, XML, or PDF

If you want to export a space or selected pages in a space to HTML, XML, or PDF, Confluence can create
a zipped archive of the HTML or XML files, or a single, downloadable PDF file.

PDF export is useful you're producing a printable user manual from your documentation space for example.
The HTML export can be used to convert your site content to a static website, and finally the XML export can
be used to import your space content into another Confluence space (running the same or later version of
Confluence).

To export pages to HTML, XML, or PDF:

Go to the space and chooseSpace tools>Content Toolsfrom the bottom of the sidebar
ChooseExport
Select eitherHTML,XML, or PDF, then chooseNext
Select the type of export:
® Normal Export (HTML and PDF) to produce an HTML or PDF file containing ONLY the pages
that you have permission to view.
® Full Export (XML) to produce an XML file containing all the pages in the space, including
those that you do not have permission to view.
® Custom Export if you want to export selected pages only, or if you want to exclude comments
from the export.

N



Confluence 7.15 Documentation

5. Choose whether to IncludePage Numbers (PDF only)

6. ChooseExport.

When the export process has finished, you can download the zipped archive or PDF.

What's included in the export?

The following content is included in space exports.

PDF export | XML export

Pages Yes Yes
Blogs No Yes
Comments No Optional
Attachments Images only | Yes
Unpublished changes No Yes
Page numbers Optional N/A
Restricted pages Only those Yes, they
and blog posts you can view | remain
restricted

Customizing the appearance of PDF exports

HTML export
Yes
No
Optional
Yes
No
N/A

Only those
you can view

You can add a title page, table of contents, and customized headers and footers to the PDF output. For
more advanced customizations, you can apply Cascading Style Sheet (CSS) modifications. These
customizations are specific to each space, and you need the 'Space Administrator' permission to apply these
customizations. For more information, seeCustomize Exports to PDF.

Notes on PDF exporting

® To export a PDF containing international text, seeCreate a PDF in Another Language

® Confluence's PDF export feature is designed to handle a wide variety of content, but on rare
occasions the PDF Export process may fail due to an unrecognized customization. If that happens,
the PDF export screen will indicate the title of the page in which the problem occurred, to help you

diagnose the cause of the failure.

® Tables that exceed the width of a page, particularly those with images in them, might be cut off in the
PDF. SeeWide tables are cut off in PDF exportsfor some suggested workarounds.
® |n Confluence Data Center, PDF exports are handled by the external process pool.

Notes on Word exporting

® Only the first 50 images attached to the page are exported to your Word document. This is to prevent
out of memory errors affecting your whole Confluence site. See

[J CONFSERVER-34211 - If a page with big number of images Exported to Word, some images

are invisible SHORT TERM BACKLOG

for more information, and to find out how you can temporarily increase this limit using a system

property.

Notes on HTML exporting

® In the zip file, page attachments are placed in individual folders with names in the following format:

... \downl oad\ at t achnment s\ xxxxxx

where 'Xxxxxxx"' is the page ID of the page containing the attachments.

® To customize the HTML output, you'll need to modify the fileconf | uence-x.y. z-jar/ com
[ atl assi an/ conf | uence/ pages/ Page. ht m export. vm To learn how to repackage this file,

seeHow to Edit Files in Confluence JAR Files
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Notes on XML exporting

® You can only import a space into the same or later Confluence version.You can't import a space

into an earlierversion.
® Team Calendars aren't included in XML exports.

® |f you're doing the export for backup purposes, consider another means of backup. See Production
Backup Strategy.

® |If you are running Confluence behind Apache HTTP Server and are facing timeout errors, please

consider creating the export directly from Tomcat, instead of going through Apache. This will speed
up the process and prevent timeouts.

See Restoring a Space for notes on restrictions when importing a space into Confluence Server.

Migrating content to Confluence Cloud

If you're migrating from Confluence Server to Confluence Cloud, you can use theConfluence Cloud Migration
Assistantto migrate your content and spaces.
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Customize Exports to PDF

Confluence provides a basic PDF export that you

can customize and style to suit your needs. On this page:

You need Space Admin permissions to customize ® How it works

PDF exports in a space, and Confluence ® |imitations
Administrator global permissions to customize PDF ® Change the PDF layout
exports for the whole site. * PDF Layout examples

® Title page

® Header or footer
® Change the PDF stylesheet
® PDF Stylesheet examples
Page size
Page orientation
Page margins
Page breaks
Word wrapping
Title page
Table of contents
Tables
Page numbers
Headings
Other formatting

Related pages:

® Advanced PDF Export Customizations

How it works

When someone exports a space to PDF, Confluence will apply any layout and styling directions it finds in the
current space or set globally for the whole site.

® The PDF Layout allows you to add a title page to your PDF, and add a header and footer to all pages.
®* The PDF Stylesheet allows you to change the look of the PDF. You can change just about anything,
including the paper size, fonts and colours, spacing, and control behaviours like page breaks.

Both the PDF Layout and PDF Stylesheet can be customized on a space by space basis, or globally for the
whole site. Space customizations will always completley override any global customizations. This means you
can't mix and match and set some items globally and others at the space level.

Limitations
There are a few limitations to be aware of:

® Changes to the PDF layout only apply to space exports, not to single page exports (via®** >Export to
PDF).

® Confluence Server and Data Center process space exports slightly differently. This means that some
options, like adding page numbers via CSS, aren't available in PDFs created with Data Center. We
recommend selecting Include page numbers on the export screen if you need to number your pages.

® \We provide a number of example customizations to get you started, however Atlassian Support can't
help you with styling your PDFs or problems introduced by your customizations. If you're newto CSS,
you might want to get help from anAtlassian Solution Partner, or check out a Marketplace app likeScro
Il PDF Exporterwhich has a WYSIWYG editor to help you produce beautifully styled PDFs.

Change the PDF layout

The PDF Layout is where you add a title page, header, or footer to your PDF exports.The PDF layout fields
accept HTML. You can include inline CSS in the HTML too.
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To change the PDF layout for the whole site:

* Go tom> General Configuration>PDF Layout.
You need Confluence Administrator global permissions to do this.
You need
® Choose Edit, then add your customizations in the Title, Header, or Footer fields.

To change the PDF layout for a specific space:
® Go to the space and chooseSpace tools>Look and Feelfrom the bottom of the sidebarYou'll needSp
ace Admin permissionsto do this.

® Choose PDF Layout.
® Choose Edit, thenadd your customizations in the Title, Header or Footer fields

PDF Layout examples

Here are some examples of things you can do in the PDF Layout. The PDF layout can accept HTML and
inline CSS.

Title page

In this example we've added the title "Documentation for Confluence”, a logo, and an additional title
"Contents" above the table of contents.

<div class="fsTitl ePage">
<inmg src="/downl oad/ attachment s/ 169118009/ at | assi an_| ogo. png" />
<div class="fsDocTitle">Docunentation for Confluence</div>
</ div>
<div class="tocTitle">Contents</div>

The logo image we've used is attached to a Confluence page in the same site. You can find out the
attachment ID by right clicking the image on the page, and copying its location.

Header or footer

In this example we've added plain text to the footer with some copyright information, and included a link.

Created in 2018 by Atlassian. Licensed under a <a href="http://creativecommons.org/licenses/by/ 2.5/ aul"
>Creative Commons Attribution 2.5 Australia License</a>.

Change the PDF stylesheet

The PDF Stylesheet allows you to change the appearance of your PDF. This includes things likepaper size,
fonts, colours, spacing, and other styling.

To change the PDF stylesheet for the whole site:

* Go tom> General Configuration>PDF Stylesheet.
You need Confluence Administratorglobal permissionsto do this.
You need

® ChooseEdit, then add your CSS.

To change the PDF stylesheet for a specific space:
® Go to the space and chooseSpace tools>Look and Feelfrom the bottom of the sidebarYou'll needSp
ace Admin permissionsto do this.

® ChoosePDF Stylesheet.
® ChooseEdit, thenadd your CSS.

Created in 2021 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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PDF Stylesheet examples
Here are some examples of common CSS overrides that you can use in your PDF Stylesheet.

The default CSS rules will apply unless you have specified an override in the PDF Stylesheet.

Page size

The default page size is US Letter(8.5 inches wide by 11 inches long). To override this behaviour and
specify a particular size, add asi zeproperty to theCSS @agerule.

For example to export your spacein A4 size:

@age
{
/*The A4 paper size is 210 nmw de by 297 mm | ong*/

si ze: 210mm 297mm
}

Page orientation

To change the page orientation of your PDF document, reverse the order of the values declared in the@age
rule'ssi zeproperty. The first and second values of this property represent the width and height of the page,
respectively.

For example, to generate an A4 PDF in landscape, your@agerule might look like this:

@age
{

/*A4-sized pages in |andscape orientation are 297 nmw de by 210 mm | ong*/
size: 297mm 210mMm
}

Page margins

The default margins are 0.5". To set all margins to 15 mm, with a paper size of A4, edit theCSS @agerule
in the PDF Stylesheet, like this:

@age
{
size: 210mm 297mMm

margi n: 15mm
}

To set the margins independently, edit the@agerule like this:

@age

{

mar gi n-top: 2.54cm
mar gi n-bottom 2. 54cm
margin-left: 1.27cm
margin-right: 1.27cm
}

To set margins to include a gutter for binding a printed document, you can use the: | ef t and: ri ght pseudo-
classes, as follows:
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@age :left

{

margin-left: 4cm
margi n-right: 3cm
}

@age :right

{

margin-left: 3cm
mar gi n-right: 4cm
}

@age :first

{

margi n-top: 10cm/* Top margin on first page 10cm */

}

In the example above we've also used the: fi r st pseudo-class to define different margins for the title page.

Page breaks

By default, each Confluence page will start on a new page in the PDF. If you don't want each Confluence
page to start on a new page, you can override the default page breaks using the following CSS:

.pagetitle {
page- br eak- bef ore: auto;

}

This behaviour changed in Confluence 6.13. If you're using Confluence 6.12 or earlier, page breaks are not
added before each page title.

1 If you're using Confluence Data Center, you won't be able to change this behavior, as PDFs are
generated page by page in the external process pool, and then combined together once all pages
are complete.

Word wrapping

Long, unbreakable words or strings (such as a URL) will automatically wrap to fit the page width, or cell
width if in a table.

If you don't want words or long strings to break you can use the following CSS:
div {

word-wrap: normal !inportant;

}

This may mean that the table formatting in your PDF is problematic, and very long content may overflow,
and be cut off the page.
Title page

If you have added a title page in the PDF layout, you can use the following rules to change the appearance
of the title page and title text.
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.fsTitl ePage

{

margin-left: auto;

mar gi n-top: 50mMm

margi n-right: auto;
page- break-after: al ways

}

fsTitle
{

font-size: 42px;
font-wei ght: bold;
margin: 72px 0 4px O;
text-align:center;

}

Table of contents

A table of contents is included by default when you export a space to PDF. It will appear at the start of the
document, or after the title page, if you've configured a title page in thePDF layout.

To omit the table of contents, use the following override:

div.toc

{
di spl ay: none;

}

The table of contents uses a leader character to visually connect the page title with it's page number. By
default this is a dot. Allowed values aredot t ed,sol i dandspace. You can also use a string, for examplel ea
der(". . . ™).

The example belowuses solid line, instead of dots.

span. t ocl ead: before

{

content: |eader(solid);

}

Tables

When you export a page that contains a table, we'll reduce the width of the table columns as much as
possible, so that the whole table fits comfortably on the page. Individual columns are resized to fit the
contents of each column.

If you prefer table columns to always be of equal width, you can use the following CSS:

tabl e. fi xedTabl eLayout {
tabl e-1ayout: fixed !inportant;
wi dth: 98%!inportant;

Any images in a table will be exported using the size set in the editor. If your table contains large images,
part of the table may be cut off when exported to PDF. To ensure that nothing is cut off, we recommend
resizing images in the editor, so that the total width does not exceed about 600px (for an A4 page in portrait
orientation).

Alternatively you can use the following CSS to fit images to the available width:

tabl e i my. confl uence- enbedded-i nage {
-fs-fit-images-to-wi dth: 100% !inportant;
}
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Page numbers

The best way to add page numbers to your document is to select Include page numbers on the export
screen. If you're using Confluence Server, and want more control over where page numbers appear, you
can use CSS to add numbers instead.

I If you're using Confluence Data Center, you can't add page numbers using these methods, as PDFs
are generated page by page in the external process pool, and then combined together once all
pages are complete. Use the Include page numbers option on the export screen instead.

To add page numbers in the format "Page x of y" to the bottom of your page, add the following CSS to the
PDF stylesheet:

@age
{

@ottom center

{
content: "Page " counter(page) " of " counter(pages);
font-famly: ConfluencelnstalledFont, Helvetica, Arial, sans-serif;
font-size: 8pt;

Alternatively you can add page numbers into the footer. This requires making a change in the PDF layout
and the stylesheet.

First, add an elementin the PDF layout. In this example we'll call itpageNum

<span i d="pageNunt/>

Then, in the PDF stylesheet, style the pageNunelement as follows:

#pageNum bef ore

{

content: counter(page);

}

Headings

Heading sizes in the PDF export roughly match the sizes used on Confluence pages. You can easily
override them as follows:

hi {

/* Customstyling */
}

h2 {
/* Customstyling */
}

This behaviour changed in Confluence 6.13. In Confluence 6.12 and earlier, headings were demoted based
on the position of the page in the page tree. Now headings are a consistent size on every page.

Other formatting
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You can use the stylesheet to customize the output of just about anything on the page,including fonts,
tables, line spacing, macros, etc. The export engine works directly from the HTML output produced by
Confluence. Therefore, the first step in customizing something is to find a selector for the HTML element
produced by Confluence or the Confluence macro. Then add a CSS rule to the PDF stylesheet.
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Advanced PDF Export Customizations

This page provides information about ‘advanced'
PDF export customizations. These expand upon the
regular customizations described in Customize
Exports to PDF.

i. The information below is for advanced users. Be
aware that the advanced customizations described
below require knowledge of certain parts of
Confluence, and of CSS and HTML. Customizations
are not supported by Atlassian, so oursupport
engineers won't be able to help you with these
modifications.

Header and Footer

On this page:

® Header and Footer
® Adding Headers and Footers to
Single Page Exports
¢ Adding Images to Headers and
Footers
Incorporating Other Fonts
Adding a Dynamic Title to the Title Page
Hiding Text from the PDF Output
Indexing
Notes

Related pages:

® Customize Exports to PDF
® Create a PDF in Another Language

Adding Headers and Footers to Single Page Exports

Single page exports don't support adding HTML headers and footers via the PDF Layout page, but you can
use CSS rules in the PDF Stylesheet page (Space tools >Look and Feel > PDF Stylesheet)to produce

headers and/or footers for a single page export.

For custom headers, define any of the following ruleswithin your@agerule:@ op- 1 ef t ,@ op- cent er, and@
t op-ri ght. These rules allow you to define thecont ent of the left-hand side, centre and right-hand side of

your page's header area, respectively.

For custom footers, define @ottom | eft, @ott om cent er and @ott om ri ght rules within your @age

rule.

For example, the following rules add a document title at the centre of the header and a page number at the

centre of the footer:

CSS - PDF Stylesheet

@age
{

@ op- center

{

content: "Docunent Title CGoes Here"; /* This is the content that will appear in the header */
font-famly: ConfluencelnstalledFont, Helvetica, Arial, sans-serif;

font-size: 8pt;
}

@ottom center

{

content: "Page "

counter(page); /* This is the content that will appear in the footer */

font-famly: ConfluencelnstalledFont, Helvetica, Arial, sans-serif;

font-size: 8pt;
}

/* Any other page-specific rules */

Notes:
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® Thefont-fam |y andfont-size properties ensure that the header and footer text is rendered in
the same default font style used for the body text, based on the default CSS rules.

® |tis not possible to use this method to insert images (stored as attachments within your Confluence
instance) into the headers and footers of single page exports.

Adding Images to Headers and Footers

To insert an image into the header or footer, add HTML to the Header or Footer section of the PDF Layout
screen.

The following example uses an HTML i ng element with sr ¢ attribute to add an image to the left of the
header. The sr c attribute refers to an image attached to a Confluence page. The image element is usually
placed within a di v element container.

HTML - PDF Layout: Header Section

<div style="margin-top: 10.0mm ">
<inmg src="https://confluence. atl assi an. comf downl oad/ att achnent s/ 12346/ header - i mage. png" />
</div>

In the example above, the header includes an image called 'header-image.png'. The "12346" in the sr ¢
attribute is the ID number of the page to which the image is attached.

Follow these instructions to include an image on your page:

Attach the image to a Confluence page.

View the list of attachments on that page, then right-click the image and copy its location.

Paste the link into the appropriatesr c="" attribute in your PDF Stylesheet, as shown above.

Edit the image URL so that it is relative, by removing the first part of the URL before/ downl oad/ . . ..

AWNR

Notes:

® This example uses an inline CSS propertynmar gi n-t op in the st yl e attribute to force the image
away from the top of the page by 10mm. This comes in handy when your header image is large
enough to touch or spill over the top of the page.

® |ikewise, for footers, you can use the nar gi n- bot t om XXmmproperty to force an image away from
the bottom of the page by 'XX' mm.

® Very large images can spill over into the body of a page or alter the position of text or other elements
used within a header or footer. In such situations, it is recommended that you reduce the size of the
image and then attach it to your Confluence page again. If you prefer to keep the image size and
want to move the content lower instead, you can do so by configuring the mar gi n-t op properties in
the @age CSS rule.

® By default, a header or footer image is aligned to the left-hand side of the page. However, you can
align this image to the centre or right-hand side of a page by adding either the t ext - al i gn: cent er
ortext-align:right properties to your st yl e attribute. For example, to align the header image to
the right-hand side of the page, your st yl e attribute would look similar to this: st yl e=" nar gi n-
top: 10nm text-align:right".

Incorporating Other Fonts

By default, Confluence provides Times New Roman, Helvetica or Courier fonts for use in PDF exports. You
can use your own fonts for PDF exports by declaring them in a@ ont - f aceCSS rule in your PDF
Stylesheet.

The following CSS rule example shows how to declare the Consolas font and apply it to some elements for
your PDF export:

CSS - PDF Stylesheet

@ont-face { src: url(file:///usr/share/fonts/Consolas.ttf); -fs-pdf-font-enbed: enbed; } .code pre, .
prefornatted pre, tt, kbd, code, sanp { font-famly: Consol as, nonospace; font-size: 9pt; }
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The font path specified in the CSS must be the path to the font on the Confluence server.

Adding a Dynamic Title to the Title Page

When you export an arbitrary set of pages from Confluence, you may like to have a corresponding title
added to the cover (or title) page automatically. This can be done (in a somewhat irregular way) by using the
top level item from the default table of contents as the title. This method relies on having the exported pages
structured as sub-pages of the top-level page. In other words, the pages to be exported should consist of a
page (at the top-level) and all of its child pages. The result is that thetitle that appears on the cover page
changes depending on the top-level page that is used for the export.

The CSS below moves, and styles, the top-level TOC item for use as the title on the cover page, and turns
off the leader and page number normally associated with this item in the TOC.

CSS - PDF Stylesheet

.fsTitlePage { position:relative; left:0px; } /* Turn off the default section nunbering for this TOC
item*/ .toclvlO:before { content: &quot; &quot;; counter-reset: chapter 0; } /* Hide the default page
nunbering for this TOC item*/ .toclvl0 .tocnum{ display: none; } /* Mve and style this TOC item?*/ .
toclvl0 { position:absolute; top:250px; font-size: 42px; font-weight: bold; margin: 72px 0 4px 0; text-
align:center; }

Hiding Text from the PDF Output

This section describes a way to hide text from your PDF export. In other words, you can have text on the
Confluence page that will not appear in the PDF export.

There are three steps:
1. Follow the instructions to define the NoPrint user macro.

2. Use the NoPrint macro to mark some text on a Confluence page.
3. Add the following CSS to your PDF stylesheet to make the PDF export recognize the NoPrint macro:

CSS - PDF Stylesheet

.noprint { display: none ; }

Indexing

To obtain an index at the end of the exported PDF file, consider using theScroll Wiki PDF Exporter pluginthat
is produced by K15t Software GmbH.

Notes

If styling is not working as expected, it is useful to look at theintermediary HTML source to which the CSS is
applied. This intermediary HTML is created whenever you create anHTML exportthat containsmultiple
pages, and is stored in thet enpdirectory in Confluence's home directory. For example:

/tenp/ ht M export-20110308- 154047- 1/ export-internedi at e- 154047-2. ht m
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Create a PDF in Another Language

To export a Confluence page written in a language
other than English, you'll need the necessary font Related pages:
for that language.

® Export Content to Word, PDF, HTML and
XML

Upload a Font File to Confluence

1.

Find the appropriate font file:
®* Windows users:All font files in Windows are stored in a directory called:

C: \ W NDOWB\ Font s

® Unix users:All font files in Unix are stored in:

/usr/share/fonts

® Microsoft True Type core fonts such as Verdana can be downloaded from this page:http://coref
onts.sourceforge.net/
Copy the font file into a temporary folder, for example a folder on your desktop.

Choose thecog icon E then chooseGeneral Configurationthen choosePDF Export Language
Support.

Upload the file you copied in step 2.

Chooselnstall.

Notes

The only font files supported aretrue type fontsandtrue type collections. The accepted file extensions
are *.ttf and *.ttc.

Confluence can only storeonefont file at any one time. Please create a collection to install more than
one *.ttf files.

We recommend that you use Unicode font Verdana for correct character encoding and exporting to
PDF.

® For symbols, if the other fonts do not work, try Seguisym
® If the font file size is bigger thanyourcurrent attachment size limit, you will not be able to upload it.

Please increase theattachment size limittemporarilyand re-upload again. An improvement of the error
messaging is tracked at Ll CONFSERVER 24706 CLOSED

To make use of an installed font in yourPDF Export style sheet (CSS)refer to it by the font-family
ConfluencelnstalledFont.
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Pages and blogs

Pages and blog posts allow you to capture and share information in

Confluence. Related pages:

. . ) . . ] ® Create and Edit
Whether it's taking down some quick notes from a meeting, writing a require Pages

ments page, or letting your teammates know about the company's latest * Blog Posts
marketing push you can create it as a Confluence page or blog post. ® The Editor

. _ * Page Templates
Pagesare great for when you want the information to last and evolve over ® Delete or Restore
time. If it's a point-in-time update or one-time communication then a blog a Page
postis the way to go. These aren't hard-and-fast rules; they're just pointers * Spaces

to give you a place to start.

Each Confluence space, including your personal space, allows you to
create pages in it, and has its own blog where you can create posts. If
you're not sure what a space is, or what you can do with spaces, check out
our page onSpaces.

Take a look at the below pages to learn more about pages and blog posts in Confluence.

Create and Edit Pages

Blog Posts

The Editor

Move and Reorder Pages

Copy a Page

Delete or Restore a Page

Add, Remove and Search for Labels
Drafts

Page Restrictions

Links

Anchors

Tables

Add, Assign, and View Tasks
Autocomplete for links, files, macros and mentions
Page Layouts, Columns and Sections
Create Beautiful and Dynamic Pages
Page Templates

Blueprints

Import Content Into Confluence
Undefined Page Links

View Page Information

Page History and Page Comparison Views
Confluence Markup



Create and Edit Pages

Create a page

On this page:

You can create a page from anywhere in Confluence; just chooseCreatein

the header and you're ready to go. Pages are the place to capture all your
important (and unimportant) information; start with a blank page and add
rich text,tasks,images,macrosandlinks, or use one of the usefulblueprintsto

capturemeeting notes,decisions, and more.

* Create a page
Edit together
® Collaborate or
restrict
® Organize and move
® Other page actions
®* Notes

(-:f} If you want to quickly create a blank page, hit the Create button in the header; if you want to create
a page from a template, hit the Create from template button.

 cee | -

1. Create blank page
2. Create from template

Dev team -

o — Select space

Blank page
Start with a blank page.

DACI decision

ke

#
ﬁ Define the roles and responsibilities for
making high-impact or high-risk decisions.
@— e
E Experience canvas
Make sure your work is user-centered,
technically sound, and makes sense for the
" Health monitor

el banlth

Add or customise templates for the selected space

Help

Farent: Dev team HOMmMe @e— o

Blog post
Share news and announcements with your
team.

Decision
Record important project decisions and
communicate them with your team,

File list
Upload, preview and share files with your
team.

How-to article

L P L )

i

Create elLES

1. Select space: choose the space where you'll create the content.
2. Page templates: create a page from a template or create other types of content.

3. Parent page: your page will be a child of this page.

Once youdecide on a blank page or blueprint, you'll be taken straight into the Confluence editor. The editor
is where you'll name or rename your page, add the content, and format it to look great. When you've added
some content, choose>Preview to take a peek at what your finished page will look like, andPublish when
you're ready to make it appear in the space.

After you save you'll see the page in 'view' mode. You can re-enter the editor any time by choosingEdit or
pressingE on your keyboard.
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Creats

2 Confluence Spaces v

People

4 Pages & & # Edit 7 Save for later © Watching < Share

_ﬂi Teams in Spaca
Teams in Space Home

Created by Alana Gean st modified by Rach Admin on Jan 17, 2018

B Pages

3% Bilog

SPACE SHORTCUTS

© Welcome to your new spacel
Confluence spaces are great for sharing content and news with your team.
This is the home page for Teams in Space. Right now it shows recent space
activily, bul you ¢an customize this page in anyway you [ike. Sean along the
fefthand side to see important pagas in this space.

B Declsion log
& Our Kanban board
B Media assets

PAGE TREE You can customize the left navigation to fit your team.

Meeting notes

Decision log

Recent space activity Space contributors

Product Requirements Alana Grant Alana Grant (7 hours ago)

]
)
* Product Planning
3
>

-

» 8 B Where should we store
our files? updated about
& hours ago = view

Teams in Space PR

* Meet the SeeSpaceEZ Team

Rach Admin {7 hours ago)
Judd (2 days agao)
Ryan Lee (5 days ago)

+ Team Sprint Calendar Emad Abdi (b days ago)

change
Rach Admin

B Where should we store
our files? updated about
B hours ago « view

+ File lists

* Media assets

£} Space tools “t

1. Confluence header: create blank pages, pages from templates and visit spaces or your profile.
2. Space sidebar: access pages, blogs and administer the space.
3. Page tools: edit or share the page, watch it to get updates and perform more actions.

@. Another useful way to create a page is to use theCreate from Template Macro. This macro allows
you to choose a page template, and adds a button to the page allowing one-click page creation. If
you want others to create pages using this template, this is a great option.

Edit together
Need input from your team members? Multiple people can edit your page at the same time.

Hit the Invite button in the editor and either grab the link, or enter some people or groups to invite by email (t
hey need the appropriate Confluence and space permissions of course).

SeeCollaborative editing for all the ins and outs.

Collaborate or restrict

Once you've created a page, you can decide if you want to keep it private, usingrestrictions,or collaborate on
it with others using@mentions,sharing, andcomments.

Organize and move

You can also organize pages in a hierarchy, with child and/or parent pages for closely related content. When
you navigate to a Confluence page and choose theCreatebutton in the header, the page you're creating will
by default be a child of the page you're viewing. Have as many child pages and levels in the hierarchy as
you need to, andmove pagesif you want to change their location.

If you want to view all pages in a Confluence space, choosePages in the sidebar.

G} Each time you create a page, you're creating it in a space . Spaces are containers used to contain
pages with related content, so you can set them up for each team in your organization, for projects,
a combination of both, or for any reason you want to group pages together. SeeSpacesfor more
information.

Other page actions
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Copy a page and its child pages

Delete a page or remove a specific version of a page

Monitor page updates and other activity through page notifications
View page history, and manage and compare versions of a page
Search page content, including attachments

Export pages toWord, PDF, HTML or XML

Like a page

i.We recommend you don't use special characters in page or attachment names, as the page or attachment
may not be found by Confluence search, and may cause some Confluence functions to behave
unexpectedly.

G} If you rename a page, Confluence will automatically update all relative links to the page, except in
some macros . Links from external sites will be broken, unless they use the permanent URL. See Lin
ksfor more information.

Notes
You may experience problems saving extremely large pages. Confluence can accept approximately 5mb of

content (not including attached files) which is roughly equivalent to 800,000 words. If you do experience
errors that indicate the page is too large to save, you should break up the page into several smaller pages.
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Blog Posts

Blog posts are an easy way to share announcements, journal entries, status

reports, or any other timely information. Others can join in by commenting on On this page:
and/or likingyour blog post and, if you get enough of either, your post might ® Create a blog post
make it to the popular feed on the dashboard! * Move a blog post

® Restrict a blog post
Each space in Confluence, including your personal space, has it's own blog. * Delete a blog post
To view a space's blog, go to a space and chooseBlogin the sidebar.You'll ® Export a blog post

see a list of the latest blog posts, and you can click through to earlier posts
via the navigation area in the sidebar. Related pages:

® Subscribe to RSS
Feeds within
Confluence

® Blog Posts Macro

® Collaboration

® Export Content to
Word, PDF, HTML
and XML

Create a blog post

You can follow the same process to create a blog post as when you create
a Confluence page.

1. Navigate to the space where you want to create your blog post
2. ChooseCreate in the Confluence header and selectBlog post
3. Add your content and choosePublish

You can create blog posts from the Dashboard, but you'll need to make
sure you choose the space it's going to appear in in the create dialog.

Blog posts can be attractive and engaging in the same way a page can be, so go ahead and add images,
YouTube clips (preferably of cats), and tables to your post to really grab your audience.

To create a blog post, you need the 'Add Blog' permission. SeeSpace Permissions.

Move a blog post

If you create a blog post in the wrong space, or want to reorganize your spaces, you can move an individual
blog post to another space.

To move a blog post, go to the post and choose*** >Moveand select the new destination space.

You'll need the 'Delete blog' permission in the current space, and 'Add blog' permission in the new
(destination) space to do this.

Restrict a blog post

You can restrict a blog post so that it is only available to specific users or groups. Blog post restrictions work
in the same way aspage restrictions.

To restrict a blog post prior to publishing it, choose theUnrestrictedbutton in the footer and apply your
restrictions.To restrict a blog post after publishing, choose *** >Restrictionsand apply your restrictions.

Notes:
® Notifications are sent at the point a blog post is created - removing restrictions does not trigger a new

natification.
® As a blog post has no parent, restrictions aren't inherited.

Delete a blog post

To delete a blog post, choose*** >Delete. Deleting a blog post follows the same rules as deleting a page.

Export a blog post

You can export individual blog posts to PDF. This is useful, for example, if you want to email an internal blog
post to people outside your organization.
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SeeExport Content to Word, PDF, HTML and XML for more information on exporting blog pages to PDF.
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The Editor

The Confluence editor is what you'll use to create and edit Confluence
pages, blog posts, and comments. You can enter content as you would in a
Word document, apply formatting, and embed other content and files on the

page.

Note: To edit a page, you need the 'Add Pages' permission for the space.
See space permissions. Someone may also apply page restrictions that
prevent you from editing the page.

Edit a page or blog post

You'll be taken to the editor whenever you create a new page or blog post,
or add a comment. To edit an existing page or blog post, choose Edit at the
top of a page or press E on your keyboard.

Confluence automatically saves changes as you type. Changes are only

visible when viewing the page after you publish or update. SeeCollaborative
editing for more information on how this works.

The editor

On this page:

Edit a page or blog
post

® The editor
® Editor toolbar
® Restrictions,

labels, and
notifications
Things to help you
work faster

Find and replace
text

Invite people to
edit with you
Record change
comments and
notify watchers

Related pages:

®* Tables
® Page Layouts,

Columns and
Sections

Display Files and
Images

® |inks
® Symbols,

Emoticons and
Special Characters

The editor allows you to enter or change the title of your page; insert content including text, images, and

links; and format your content using the toolbar.

If you're renaming your page, there aresome things you should take into account.


https://confluence.atlassian.com/display/CONF715/Create+and+Edit+Pages#CreateandEditPages-rename
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Introducing Confluence

Transparency and organisation are key for modern teams. Confluence gives you a central place to keep your team's work organised and
accessible, making it easier to find the information needed to keep work moving forward.

High performing teams work together to maximise productivity. Confluence combines the speed of creating on your own with the
advantages of working together. Confluence makes it easy to create documents as a team, provide feedback in context and guickly iterate
until your work is finalised.

Ready to go What did you change? T Notify watchers Close 'f

Page content: add your page title and body text.

Page tools: add labels or restrict the page.

Insert: add files, links, images, tables and macros

Notify: notify others and leave a comment when you change a page.

Preview or revert: preview your page, view changes since last published, or revert back to last
published version (or delete the draft page, if it has never been published).

R WNR

Editor toolbar

The editor toolbar is where you format your page layoutand text, and add links, tables, images, attachments
and macros. You can also perform a find and replace, or get help using the editor by choosing thehelp icon

?.
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Other macros
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The Insert menu

The Insert menu is particularly useful. Use thelnsertmenu to include any of the following content types on

your page:
® Animage
® Alink to another Confluence page or external URL, or a link to an attachment or image
® An emoticon or symbol, or a horizontal line
[ ]

A macro(choose a specific macro, orOther Macros, from the Insert menu)

You can also use keyboard shortcuts to insert links, images, and macros. Try out the shortcuts listed below:
® Type[(square bracket) to insert a link.
® Typel(exclamation mark) to insert an image or other media.

® Type{(curly bracket) to insert a macro.

Typing any of the above shortcuts will trigger the autocomplete functionality, prompting you with a list of

2
suggestions to finish off the entry. For more shortcuts, click the help icon ° on the editor toolbar.

Restrictions, labels, and notifications

When editing a page, you may want to set restrictions on who can view or edit the page, or add labels to the
page to make it easily searchable.

Once you're ready to save, you can enter change comments to let others know what you've changed, and, if
you like, send an email notification to anyone watching the page.

Things to help you work faster

Auto-formatting

You can type Confluence wiki markup directly into the editor to have Confluence auto-format your text as

7
you type. To learn more, choose help icon " in the toolbar, then chooseEditor Autoformatting.

Autoconvert for pasted links

When you paste certain URLs into Confluence, the editor will analyze what you're pasting and automatically
convert it into something that will display well in Confluence. Examples include:

YouTube videos

Jira issue queries

Google Maps

Confluence pages, blog posts, comments, user statuses, user profiles.
Shared screenshot links from Skitch

And more.

Drag-and-drop for external images and files

You can drag files, like images, multimedia,Office files and PDFs, from your computer and drop them directly
into the editor. The contents of the file will be embedded into the page or blog post.

Drag-and-drop within the editor
In the editor panel, you can drag an image or a macro from one location to another on the page. Hover your
cursor over the image or the macro placeholder and your cursor changes to a drag-and-drop icon. Click the

image or macro and drag it to a new location.

Keyboard shortcuts

Created in 2021 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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To view the availablekeyboard shortcuts, choose the help icon ? in the editor toolbar.

Find and replace text

Click the @ iconon the toolbar, or use the keyboard shortcut Ctrl+F (Windows) or Cmd+F (Mac OS).
Search matches are highlighted in yellow. You can step through the results one by one, replace the

matching text strings one by one, or replace all matching strings at once. Find and replace works only within
the current page.

Invite people to edit with you

Speed up your draft and review cycles and get input from the right people by inviting them to edit the page
with you. The page does not need to be published.

Hit the T button in the editor and either grab the link, or add people, groups or email addresses to invite, just
likesharing a page.

Sharing or inviting someone to edit a page or blog post does not automatically grant any permissions - they
will still need the appropriate Confluence permissions to access Confluence and view or edit the page.

Up to 12 people can edit the same page at the same time (your administrator can change this limit).

Record change comments and notify watchers

When you finish editing a page, you can add a comment to let others know what you changed. Type a short
message in the change comments field in the footer. The comment will be visible in thepage history.

If you want to send a notification to people watching the page, selectNotify watchers. The change comment
will be included in the notification email.

TheNotify watcherscheckbox remembers your last selection for each page, so if you choose not to notify
people, the checkbox will be deselected for you next time you edit that page.

Notify watchers Update Close

Created in 2021 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Symbols, Emoticons and Special Characters

You can add various symbols and special characters to Confluence pages.
You can also use them in other places that display content, such as blog
posts, comments, and the dashboard welcome message.

On this page:

® |nsert emoticons
® Prevent emoticons

. 5 .
() Using Confluence Cloud?Check out our info on how toUse from appearing

symbols emojis and special charactersin the new editor.
Related pages:
Insert symbols and special characters * The Editor

1. Edit the page (if you're viewing the page, presskE on your keyboard)
2. Chooselnsertt ¥> Symbol
3. Choose a symbol to insert it

Symbol
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Cancel

Insert emoticons
There are two ways to add an emoticon, or smiley, to your page.
By choosing an emoticon from those available:

1. Choose Insert > Emoticon
2. Choose an emoticon to insert it

By typing a character combination:

You can also type the following characters to insert emoticons. This can be useful when the Insert menu is
not available, for example in an inline comment.


https://support.atlassian.com/confluence-cloud/docs/use-symbols-emojis-and-special-characters/
https://support.atlassian.com/confluence-cloud/docs/use-symbols-emojis-and-special-characters/
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Prevent emoticons from appearing

To undo the conversion of a character combination into an emoticon, press Ctrl+Z (Windows) or Cmd+Z
(Mac).

To prevent Confluence from converting text to emoticons automatically, disable 'Autoformatting' in your user
profile. See Edit Your User Settings.

Created in 2021 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
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Collaborative editing

Collaborative editing takes teamworkto the nextlevel

by lettingyou and your teamwork together in real On this page:

timeon software requirements, meeting notes,

retros, and any other Confluence page. See who's * Drafts and unpublished changes
editing the page with you, and see changes as they * Things you should know

happen.Hit T to invite more people to edit with you.

Changes save and sync automatically,so everyone
editing sees the same thing. And, because we're
saving all the time, there's no need to manually
save. Publish now or keep the draft and publish it
lateryou're in control.

Up to 12 people can edit the same page at the
same time. Your administrator can change this limit
using asystem property.

Once you and your team are done editing you can:

publish(or update if the page has previously been published) to make everyone's changes visible
close the editor andkeepeveryone's work to finish later

revertto the published version of the page, discarding everyone's unpublished changes
deletethe draft page entirely, if it has never been published.

We'll warn you if you're about to publish (or discard) other peoples' changes along with your own.

= 2 Confluence spaces v+ People Create

Paragraph v B T U Av &+ 2 12 [ 2 ¢ = = = M B & By +v = a 7

Teams in Space / Pages | Teams in Space Home [ Launch Pad Product Requirements @ 8 UNPUBLISHED CHANGES QQ Q =t ."_o

Launch Pad Product Requirements

e Background
We neecEwav to launch rockets into space, so that we can have you know... Teams in Space.

Reqguirements

User Story Description Priority
As an gperater | want to have a launch pad The launch pad will be used to blast reckets into space 1- MVP
As an operater | want to have a cancel button ~ This will be a manus| override 1- MVF'P
As an operater | want to have a turbo butten This will enable super fast launches into space 2 - Nice to have
Ready to go ihat d u changa Motify watchers Update Close

1. Invite more people:see who is editing the page and invite others to edit with you.
2. See what they're doing:watch others edit the page in real time.

Drafts and unpublished changes

What is a draft?

A draft is a page that hasneverbeen published before. Draft pages have a lozenge that saysdraft, and are
only visible to their author, and to anyone that author shares their draft with. Nobody else will be able to see
your draft, as it is only accessible from theRecently worked onlist of each of the people who've contributed
to it.

What are unpublished changes?
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A page withunpublished changesis a page that has been published, and has then had edits made to it, but
which has not yet been republished. Anyone who has unpublished edits will see the page in theirRecently
worked onlist, with a lozenge sayingunpublished changes. People who haven't contributed to the
unpublished changes won't see this lozenge.

Those unpublished changes, however, are visible in the editor, and anyone can access them by editing that
page. Therefore, if you have unpublished changes and do not want someone else making additional
changes before they can be published, you might want to temporarily restrict editing on that page (leaving
the published version of the page visible).

& Confluence Spaces ~ People Create  «+

DISCOVER b
: Recently worked on Filte Exaste Seace
@ Al updates
|22 Popular
TonaY Welcome to Confiuence
MY WO B When should we launch?  UNPUBLISHED GHANGES

@ Recently worked on

B Launch Pad Product Requirements I
B
Recently visited
® ¥ B Workshaop planning 2019 DRAFT ) g
7 Saved for later -
{

IN THE LAST MONTH T P
MY SPACES ALL Mission essentials

¥ Devteam B 2018-01-17 Meeting notes Meet the SeeSpaceEZ Team

Teams in Space Roadmap

h’ Teams in Space a Workshop outline  UNPUBLISHED CHANGES

Things you should know

Limited content auditing

We dont yet have the same auditing capabilities with collaborative editing. All page changes are currently
attributed to the person that publishes the page, rather than the person who made each specific change.

Changes in drafts aren't versioned
Were saving all the time in collaborative editing, but we dont save versions in a draft. When restoringan

earlier pageversion,you can only roll backto published versions(the page draft is deleted when you restore a
previous version)

No more personal drafts

Collaborative editing introduces a new type of draft, ashareddraft. Previously, when you edited a page but
didn't save it, Confluence would create a draft that was only visible to you (a personal draft). When
collaborative editing is turned on, Confluence creates a shared draft whenever anyone edits a page.All page
editors work on this same shared draft, and it exists untiisomeone publishes the page.

When you publish a shared draft, you're publishing all the changes you have made and changes made by
others. Publishing creates a version in the page history.

If you discard a shared draft, you're discarding all changes, including changes made by others. Because
shared drafts aren't versioned, there's no way to get a discarded draft back.

Any existing personal drafts are still available, but are no longer editable. If you edit a page, you'll see the
shared draft of the page, not your personal draft (if one exists).

If you need to get content out of your previous personal drafts head toProfile>Drafts, locate your page and
copy the contents.

Created in 2021 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.


http://creativecommons.org/licenses/by/2.5/au/

Confluence 7.15 Documentation

Personal space

© Watching
Recently viewed

Recently worked on

Profile

Tasks

Saved for later
Watches
Drafts
Network

Settings

Log Out
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Move and Reorder Pages

The easiest way to set a page's location in Confluence is to navigate to the

space where you want the page to live and, if necessary, find its parent On this page:

page and chooseCreate.Sometimes though, you'll want to change a page's

location either while you're creating it, or after it's been created. ® Set page location
or move a page

You can also move and reorder pages in the page tree (hierarchy). * Reorder pages

within a space
®* Notes about

Set page location or move a page

permissions
1. Do either of the following: Related pages:
®* While creating a page choose the locationicon i: at the top ® Create and Edit
of the page Pages
® Once a page is created choose*** >Move * Copy a Page
2. Use the tabs on the left of the 'Set Page Location' dialog to help you ® Delete or Restore
find the new space and/or parent page for your page (theCurrent a Page

locationandNew locationbreadcrumbs at the bottom of the dialog
indicate the current parent page and new parent page)

3. SelectReorderif you want to move the page to a different position
amongst the child pages (when you chooseMovein the next step,
you'll be able to reorder the page)

4. ChooseMove (If you're reordering the child pages, choose the new
position for the page and chooseReorder)

The page along with any attachments, comments, and child pages is moved to your chosen location.
Confluence will automatically adjust all links to the moved pages, to point to the page(s) in its new location.

(D When completing theNew parent pagefield, you need to select the page suggested by Confluence's
autocomplete. Typing or pasting the p